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Publication Information
The information in this manual applies only to the MARS Ambulatory ECG System Version 8 running service pack 4 or later. It does not apply
to earlier product versions. Due to continuing product innovation, specifications in this manual are subject to change without notice.

MARS, MUSE, and CardioSoft are trademarks owned by GE Medical Systems Information Technologies, Inc., a General Electric Company
going to market as GE Healthcare. All other trademarks contained herein are the property of their respective owners.

Revision Date Comments

A 25 October 2014 Internal release.

B 25 October 2014 Customer release.

C 15 May 2015 Updated the list of security keys (dongles) in Chapter 8, “Parts List”.

D 5 May 2017 Made the following changes:

• Changed supported software from SP4 to service pack 4 or later.

• Added instructions to exclude MARS processes from AV software
scans.

• Corrected MARS Web Server default port.

• Removed obsolete security keys.

To access other GE Healthcare Diagnostic Cardiology documents, go to the Common Documentation Library (CDL), located at
www.gehealthcare.com/documents, and click Cardiology.
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Service Manual Language Information

WARNING

(EN)
This service manual is available in English only.

• If a customer's service provider requires a language other than English, it is the customer's
responsibility to provide translation services.

• Do not attempt to service the equipment unless this service manual has been consulted
and is understood.

• Failure to heed this warning may result in injury to the service provider, operator, or patient,
from electric shock, mechanical or other hazards.

ПРЕДУПРЕЖДЕНИЕ

(BG)
Това упътване за работа е налично само на английски език.

• Ако доставчикът на услугата на клиента изиска друг език, задължение на клиента е
да осигури превод.

• Не използвайте оборудването, преди да сте се консултирали и разбрали упътването
за работа.

• Неспазването на това предупреждение може да доведе до нараняване на доставчика
на услугата, оператора или пациент в резултат на токов удар или механична или
друга опасност.

警告
(ZH-CN)

本维修手册仅提供英文版本。

• 如果维修服务提供商需要非英文版本，客户需自行提供翻译服务。

• 未详细阅读和完全理解本维修手册之前，不得进行维修。

• 忽略本警告可能对维修人员，操作员或患者造成触电、机械伤害或其他形式的伤害。

警告
(ZH-TW)

本維修手冊只提供英文版。

• 如果客戶的維修人員有英語以外的其他語言版本需求，則由該客戶負責提供翻
譯服務。

• 除非您已詳閱本維修手冊並了解其內容，否則切勿嘗試對本設備進行維修。

• 不重視本警告可能導致維修人員、操作人員或病患因電擊、機械因素或其他因素
而受到傷害。

UPOZORENJE

(HR)
Ove upute za servisiranje dostupne su samo na engleskom jeziku.

• Ukoliko korisnički servis zahtijeva neki drugi jezik, korisnikova je odgovornost osigurati
odgovarajući prijevod.

• Nemojte pokušavati servisirati opremu ukoliko niste konzultirali i razumjeli ove upute.

• Nepoštivanje ovog upozorenja može rezultirati ozljedama servisnog osoblja, korisnika ili
pacijenta prouzročenim električnim udarom te mehaničkim ili nekim drugim opasnostima.

VAROVÁNÍ

(CS)

Tento provozní návod existuje pouze v anglickém jazyce.

• V případě, že externí služba zákazníkům potřebuje návod v jiném jazyce, je zajištění
překladu do odpovídajícího jazyka úkolem zákazníka.

• Nesnažte se o údržbu tohoto zařízení, aniž byste si přečetli tento provozní návod a
pochopili jeho obsah.

• V případě nedodržování této varování může dojít k poranění pracovníka prodejního
servisu, obslužného personálu nebo pacientů vlivem elektrického proudu, respektive
vlivem mechanických či jiných rizik.
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Service Manual Language Information (cont'd.)

ADVARSEL

(DA)
Denne servicemanual findes kun på engelsk.

• Hvis en kundes tekniker har brug for et andet sprog end engelsk, er det kundens ansvar
at sørge for oversættelse.

• Forsøg ikke at servicere udstyret medmindre denne servicemanual har været konsulteret
og er forstået.

• Manglende overholdelse af denne advarsel kan medføre skade på grund af elektrisk,
mekanisk eller anden fare for teknikeren, operatøren eller patienten.

WAARSCHUWING

(NL)
Deze service manual is alleen in het Engels verkrijgbaar.

• Indien het onderhoudspersoneel een andere taal nodig heeft, dan is de klant
verantwoordelijk voor de vertaling ervan.

• Probeer de apparatuur niet te onderhouden voordat deze service manual geraadpleegd
en begrepen is.

• Indien deze waarschuwing niet wordt opgevolgd, zou het onderhoudspersoneel, de
gebruiker of een patiënt gewond kunnen raken als gevolg van een elektrische schok,
mechanische of andere gevaren.

HOIATUS

(ET)
Käesolev teenindusjuhend on saadaval ainult inglise keeles.

• Kui klienditeeninduse osutaja nõuab juhendit inglise keelest erinevas keeles, vastutab
klient tõlketeenuse osutamise eest.

• Ärge üritage seadmeid teenindada enne eelnevalt käesoleva teenindusjuhendiga
tutvumist ja sellest aru saamist.

• Käesoleva hoiatuse eiramine võib põhjustada teenuseosutaja, operaatori või patsiendi
vigastamist elektrilöögi, mehaanilise või muu ohu tagajärjel.

VAROITUS

(FI)
Tämä huolto-ohje on saatavilla vain englanniksi.

• Jos asiakkaan huoltohenkilöstö vaatii muuta kuin englanninkielistä materiaalia, tarvittavan
käännöksen hankkiminen on asiakkaan vastuulla.

• Älä yritä korjata laitteistoa ennen kuin olet varmasti lukenut ja ymmärtänyt tämän
huolto-ohjeen.

• Mikäli tätä varoitusta ei noudateta, seurauksena voi olla huoltohenkilöstön, laitteiston
käyttäjän tai potilaan vahingoittuminen sähköiskun, mekaanisen vian tai muun
vaaratilanteen vuoksi.

ATTENTION

(FR)
Ce manuel technique n'est disponible qu'en anglais.

• Si un service technique client souhaite obtenir ce manuel dans une autre langue que
l'anglais, il devra prendre en charge la traduction et la responsabilité du contenu.

• Ne pas tenter d'intervenir sur les équipements tant que le manuel technique n'a pas été
consulté et compris.

• Le non-respect de cet avertissement peut entraîner chez le technicien, l'opérateur ou le
patient des blessures dues à des dangers électriques, mécaniques ou autres.
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Service Manual Language Information (cont'd.)

WARNUNG

(DE)
Diese Serviceanleitung ist nur in englischer Sprache verfügbar.

• Falls der Kundendienst eine andere Sprache benötigt, muss er für eine entsprechende
Übersetzung sorgen.

• Keine Wartung durchführen, ohne diese Serviceanleitung gelesen und verstanden zu
haben.

• Bei Zuwiderhandlung kann es zu Verletzungen des Kundendiensttechnikers, des
Anwenders oder des Patienten durch Stromschläge, mechanische oder sonstige Gefahren
kommen.

ΠΡΟΕΙΔΟΠΟΙΗΣΗ

(EL)
Το παρόν εγχειρίδιο σέρβις διατίθεται στα αγγλικά μόνο.

• Εάν το άτομο παροχής σέρβις ενός πελάτη απαιτεί το παρόν εγχειρίδιο σε γλώσσα εκτός
των αγγλικών, αποτελεί ευθύνη του πελάτη να παρέχει υπηρεσίες μετάφρασης.

• Μην επιχειρήσετε την εκτέλεση εργασιών σέρβις στον εξοπλισμό εκτός εάν έχετε
συμβουλευτεί και έχετε κατανοήσει το παρόν εγχειρίδιο σέρβις.

• Εάν δεν λάβετε υπόψη την προειδοποίηση αυτή, ενδέχεται να προκληθεί τραυματισμός
στο άτομο παροχής σέρβις, στο χειριστή ή στον ασθενή από ηλεκτροπληξία, μηχανικούς
ή άλλους κινδύνους.

FIGYELMEZTETÉS

(HU)

Ez a szerviz kézikönyv kizárólag angol nyelven érhető el.

• Ha a vevő szerviz ellátója angoltól eltérő nyelvre tart igényt, akkor a vevő felelőssége
a fordítás elkészíttetése.

• Ne próbálja elkezdeni használni a berendezést, amíg a szerviz kézikönyvben leírtakat
nem értelmezték és értették meg.

• Ezen figyelmeztetés figyelmen kívül hagyása a szerviz ellátó, a működtető vagy a páciens
áramütés, mechanikai vagy egyéb veszélyhelyzet miatti sérülését eredményezheti.

AÐVÖRUN

(IS)

Þessi þjónustuhandbók er eingöngu fáanleg á ensku.

• Ef að þjónustuveitandi viðskiptamanns þarfnast annars tungumáls en ensku, er það skylda
viðskiptamanns að skaffa tungumálaþjónustu.

• Reynið ekki að afgreiða tækið nema þessi þjónustuhandbók hefur verið skoðuð og skilin.

• Brot á að sinna þessari aðvörun getur leitt til meiðsla á þjónustuveitanda, stjórnanda eða
sjúklingi frá raflosti, vélrænum eða öðrum áhættum.

PERINGATAN

(ID)
Manual servis ini hanya tersedia dalam bahasa Inggris.

• Jika penyedia jasa servis pelanggan memerlukan bahasa lain selain dari Bahasa Inggris,
merupakan tanggung jawab dari penyedia jasa servis tersebut untuk menyediakan
terjemahannya.

• Jangan mencoba melakukan servis terhadap perlengkapan kecuali telah membaca dan
memahami manual servis ini.

• Mengabaikan peringatan ini bisa mengakibatkan cedera pada penyedia servis, operator,
atau pasien, karena terkena kejut listrik, bahaya mekanis atau bahaya lainnya.
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Service Manual Language Information (cont'd.)

AVVERTENZA

(IT)
Il presente manuale di manutenzione è disponibile soltanto in Inglese.

• Se un addetto alla manutenzione richiede il manuale in una lingua diversa, il cliente è
tenuto a provvedere direttamente alla traduzione.

• Si proceda alla manutenzione dell'apparecchiatura solo dopo aver consultato il presente
manuale ed averne compreso il contenuto.

• Il non rispetto della presente avvertenza potrebbe far compiere operazioni da cui derivino
lesioni all'addetto, alla manutenzione, all'utilizzatore ed al paziente per folgorazione
elettrica, per urti meccanici od altri rischi.

警告
(JA)

このサービスマニュアルは英語版しかありません。

• サービスを担当される業者が英語以外の言語を要求される場合、翻訳作業はその業
者の責任で行うものとさせていただきます。

• このサービスマニュアルを熟読し、十分に理解をした上で装置のサービスを
行ってください。

• この警告に従わない場合、サービスを担当される方、操作員あるいは患者が、感電
や機械的又はその他の危険により負傷する可能性があります。

경고
(KO)

본서비스지침서는영어로만이용하실수있습니다.

• 고객의서비스제공자가영어이외의언어를요구할경우,번역서비스를제공하는것
은고객의책임입니다.

• 본서비스지침서를참고했고이해하지않는한은해당장비를수리하려고시도하
지마십시오.

• 이경고에유의하지않으면전기쇼크,기계상의혹은다른위험으로부터서비스제
공자,운영자혹은환자에게위해를가할수있습니다.

ЕСКЕРТУ

(KK)

Бұл қызмет көрсету бойынша нұсқаулығы тек ағылшын тілінде қолжетімді.

• Тұтынушының қызмет провайдері ағылшын тілінен басқа тілдегі нұсқаны талап етсе,
аудару бойынша қызметтерімен қамтамасыз ету тұтынушы жауапкершілігінде болуы
тиіс.

• Бұл қызмет көрсету бойынша нұсқаулығын назарға алып, түсінбегенше, жабдыққа
қызмет көрсетуден бас тартыңыз.

• Бұл ескертуді елемеу қызмет провайдері, оператор немесе емделушінің электр
шогынан, механикалық немесе басқа қауіптер нәтижесінде жарақат алуына әкелуі
мүмкін.

BRĪDINĀJUMS

(LV)
Šī apkalpotāju rokasgrāmata ir pieejama tikai angļu valodā.

• Ja apkalpošanas sniedzējam nepieciešama informācija citā, nevis angļu, valodā, klienta
pienākums ir nodrošināt tās tulkošanu.

• Neveiciet aprīkojuma apkopi, neizlasot un nesaprotot apkalpotāju rokasgrāmatu.

• Šī brīdinājuma neievērošana var radīt elektriskās strāvas trieciena, mehānisku vai citu risku
izraisītu traumu apkopes sniedzējam, operatoram vai pacientam.

ĮSPĖJIMAS

(LT)

Šis eksploatavimo vadovas yra prieinamas tik anglų kalba.

• Jei kliento paslaugų tiekėjas reikalauja vadovo kita kalba - ne anglų, numatyti vertimo
paslaugas yra kliento atsakomybė.

• Nemėginkite atlikti įrangos techninės priežiūros, nebent atsižvelgėte į šį eksploatavimo
vadovą ir jį supratote.

• Jei neatkreipsite dėmesio į šį perspėjimą, galimi sužalojimai dėl elektros šoko, mechaninių
ar kitų paslaugų tiekėjui, operatoriui ar pacientui.
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Service Manual Language Information (cont'd.)

ADVARSEL

(NO)
Denne servicehåndboken finnes bare på engelsk.

• Hvis kundens serviceleverandør trenger et annet språk, er det kundens ansvar å sørge
for oversettelse.

• Ikke forsøk å reparere utstyret uten at denne servicehåndboken er lest og forstått.

• Manglende hensyn til denne advarselen kan føre til at serviceleverandøren, operatøren
eller pasienten skades på grunn av elektrisk støt, mekaniske eller andre farer.

OSTRZEŻENIE

(PL)

Niniejszy podręcznik serwisowy dostępny jest jedynie w języku angielskim.

• Jeśli dostawca usług klienta wymaga języka innego niż angielski, zapewnienie usługi
tłumaczenia jest obowiązkiem klienta.

• Nie należy serwisować wyposażenia bez zapoznania się i zrozumienia niniejszego
podręcznika serwisowego.

• Niezastosowanie się do tego ostrzeżenia może spowodować urazy dostawcy usług,
operatora lub pacjenta w wyniku porażenia elektrycznego, zagrożenia mechanicznego
bądź innego.

AVISO

(PT-BR)
Este manual de assistência técnica só se encontra disponível em inglês.

• Se o serviço de assistência técnica do cliente não for GE, e precisar de outro idioma, será
da responsabilidade do cliente fornecer os serviços de tradução.

• Não tente reparar o equipamento sem ter consultado e compreendido este manual de
assistência técnica.

• O não cumprimento deste aviso pode por em perigo a segurança do técnico, operador ou
paciente devido a choques elétricos, mecânicos ou outros.

AVISO

(PT-PT)
Este manual técnico só se encontra disponível em inglês.

• Se a assistência técnica do cliente solicitar estes manuais noutro idioma, é da
responsabilidade do cliente fornecer os serviços de tradução.

• Não tente reparar o equipamento sem ter consultado e compreendido este manual
técnico.

• O não cumprimento deste aviso pode provocar lesões ao técnico, ao utilizador ou ao
paciente devido a choques eléctricos, mecânicos ou outros.

AVERTISMENT

(RO)
Acest manual de service este disponibil numai în limba engleză.

• Dacă un furnizor de servicii pentru clienţi necesită o altă limbă decât cea engleză, este de
datoria clientului să furnizeze o traducere.

• Nu încercaţi să reparaţi echipamentul decât ulterior consultării şi înţelegerii acestui
manual de service.

• Ignorarea acestui avertisment ar putea duce la rănirea depanatorului, operatorului sau
pacientului în urma pericolelor de electrocutare, mecanice sau de altă natură.

ПРЕДУПРЕЖДЕНИЕ

(RU)
Настоящее руководство по обслуживанию предлагается только на английском языке.

• Если сервисному персоналу клиента необходимо руководство не на английском, а на
каком-то другом языке, клиенту следует обеспечить перевод самостоятельно.

• Прежде чем приступать к обслуживанию оборудования, обязательно обратитесь к
настоящему руководству и внимательно изучите изложенные в нем сведения.

• Несоблюдение требований данного предупреждения может привести к тому, что
специалисты по обслуживанию, операторы или пациенты получат удар электрическим
током, механическую травму или другое повреждение.
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Service Manual Language Information (cont'd.)

UPOZORENJE

(SR)
Ovo servisno uputstvo je dostupno samo na engleskom jeziku.

• Ako klijentov serviser zahteva neki drugi jezik, klijent je dužan da obezbedi prevodilačke
usluge.

• Ne pokušavajte da opravite uređaj ako niste pročitali i razumeli ovo servisno uputstvo.

• Zanemarivanje ovog upozorenja može dovesti do povređivanja servisera, rukovaoca ili
pacijenta usled strujnog udara, ili mehaničkih i drugih opasnosti.

VAROVANIE

(SK)
Tento návod na obsluhu je k dispozícii len v angličtine.

• Ak zákazníkov poskytovateľ služieb vyžaduje iný jazyk ako angličtinu, poskytnutie
prekladateľských služieb je zodpovednosťou zákazníka.

• Nepokúšajte sa o obsluhu zariadenia skôr, ako si neprečítate návod na obsluhu a
neporozumiete mu.

• Zanedbanie tohto varovania môže vyústiť do zranenia poskytovateľa služieb, obsluhujúcej
osoby alebo pacienta elektrickým prúdom, mechanickým alebo iným nebezpečenstvom.

OPOZORILO

(SL)
Ta servisni priročnik je na voljo samo v angleškem jeziku.

• Če ponudnik storitve stranke potrebuje priročnik v drugem jeziku, mora stranka zagotoviti
prevod.

• Ne poskušajte servisirati opreme, če tega priročnika niste v celoti prebrali in razumeli.

• Če tega opozorila ne upoštevate, se lahko zaradi električnega udara, mehanskih ali drugih
nevarnosti poškoduje ponudnik storitev, operater ali bolnik.

ADVERTENCIA

(ES)
Este manual de servicio sólo existe en inglés.

• Si el encargado de mantenimiento de un cliente necesita un idioma que no sea el inglés, el
cliente deberá encargarse de la traducción del manual.

• No se deberá dar servicio técnico al equipo, sin haber consultado y comprendido este
manual de servicio.

• La no observancia del presente aviso puede dar lugar a que el proveedor de servicios, el
operador o el paciente sufran lesiones provocadas por causas eléctricas, mecánicas o
de otra naturaleza.

VARNING

(SV)
Den här servicehandboken finns bara tillgänglig på engelska.

• Om en kunds servicetekniker har behov av ett annat språk än engelska ansvarar kunden
för att tillhandahålla översättningstjänster.

• Försök inte utföra service på utrustningen om du inte har läst och förstår den här
servicehandboken.

• Om du inte tar hänsyn till den här varningen kan det resultera i skador på serviceteknikern,
operatören eller patienten till följd av elektriska stötar, mekaniska faror eller andra faror.

UYARI

(TR)
Bu servis kılavuzunun sadece İngilizcesi mevcuttur.

• Eğer müşteri teknisyeni bu kılavuzu İngilizce dışında bir başka lisandan talep ederse, bunu
tercüme ettirmek müşteriye düşer.

• Servis kılavuzunu okuyup anlamadan ekipmanlara müdahale etmeyiniz.

• Bu uyarıya uyulmaması, elektrik, mekanik veya diğer tehlikelerden dolayı teknisyen,
operatör veya hastanın yaralanmasına yol açabilir.
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Service Manual Language Information (cont'd.)

ЗАСТЕРЕЖЕННЯ

(UK)

Дане керівництво з сервісного обслуговування постачається виключно англійською мовою.

• Якщо сервісний інженер потребує керівництво іншою мовою, користувач зобов'язаний
забезпечити послуги перекладача.

• Не намагайтеся здійснювати технічне обслуговування даного обладнання, якщо
ви не читали, або не зрозуміли інформацію, надану в керівництві з сервісного
обслуговування.

• Недотримання цього застереження може призвести до травмування сервісного
інженера, користувача даного обладнання або пацієнта внаслідок електричного шоку,
механічного ушкодження або з інших причин невірного обслуговування обладнання.

CẢNH BÁO

(VI)

Tài Liệu Hướng Dẫn Sửa Chữa chỉ có bản tiếng Anh.

• Nếu các đơn vị cung cấp dịch vụ cho khách hàng yêu cầu một ngôn ngữ nào khác tiếng
Anh, thì khách hàng sẽ có trách nhiệm cung cấp các dịch vụ dịch thuật.

• Không được sửa chữa thiết bị trừ khi đã tham khảo và hiểu Tài liệu Hướng dẫn Sửa chữa.

• Không tuân thủ những cảnh báo này có thể dẫn đến các tổn thương cho người thực
hiện sửa chữa, người vận hành hay bệnh nhân, do sốc điện, các rủi ro về cơ khí hay
các rủi ro khác.
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1
Manual Information

This chapter provides general information about this document (purpose, audience,
and conventions), identifies related documents, prescribes precautions for the safe
use of the system, details service responsibilities, and instructs you on how to locate
security updates for third-party software approved for use with the system.

For an overview of the MARS system, see Chapter 2, “System Overview and Setup”.

Manual Purpose
This manual provides technical information to service and technical personnel so
they can install and maintain the MARS Ambulatory ECG System. Where necessary,
the manual identifies additional sources for relevant information and/or technical
assistance.

This manual is intended only for use with MARS version 8 and systems that have
been qualified for use with MARS version 8 running service pack 4 or later. For
earlier versions of MARS and systems supporting earlier versions, refer to the MARS
Ambulatory ECG System Service Manual that originally shipped with your product.

See the MARS V8 Operator’s Manual (PN 2083129–003) for the instructions necessary
to operate the system safely in accordance with its function and intended use.

Intended Audience
This manual is intended to be used by trained GE Healthcare service personnel,
approved third party service personnel, and local biomedical and IT personnel.
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Documentation Conventions
The following conventions are used in this manual.

Typographical Conventions
Style Definition

Bold Text Indicates keys on the keyboard, text to enter, or hardware items such
as buttons or switches on the equipment.

Italicized-Bold Text Indicates software terms that identify menu items, buttons or options
in various windows.

Ctrl+Esc Indicates a keyboard operation. A (+) sign between the names of two
keys indicates you press and hold the first key while pressing the
second key once.
For example, “Press Ctrl+Esc” means to press and hold down the Ctrl
key while pressing the Esc key.

<Space> Indicates that you must press the spacebar.
When instructions are given for typing a precise text string with one
or more spaces, the point where the spacebar must be pressed is
indicated as: <Space>. The purpose of the < > brackets is to ensure
you press the spacebar when required.

Enter Indicates that you must press the “Enter” or “Return” key on the
keyboard. Do not type “Enter”.

Note Provides application tips or other useful information to ensure that you
get the most from your system.

Illustrations
All illustrations in the manual are provided as examples only. Depending on system
configuration, screen shots that appear in the manual may differ from the screens
as they appear on your system.

All patient names and data are fictitious. Any similarity to actual persons is
coincidental.

Regulatory and Safety Information
Regulatory and Safety Information outlines the responsibility of the manufacturer,
general safety information for the user, and warnings and cautions relevant to this
system.

The user should become familiar with the safety instructions, and read and understand
all instructions before attempting to use this system.

Disregarding the safety information provided is considered abnormal use of the
system.

Safety Conventions
The terms DANGER, WARNING, and CAUTION are used throughout this manual to point
out hazards, and to designate a degree or level of seriousness. Familiarize yourself
with their definitions and significance.
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A Hazard is a source of potential injury to a person.

Convention Definition

DANGER Indicates an imminent hazard which, if not avoided, will result in death
or serious injury.

WARNING Indicates a potential hazard or unsafe practice which, if not avoided,
could result in death or serious injury.

CAUTION Indicates a potential hazard or unsafe practice which, if not avoided,
could result in minor personal injury or product/property damage.

Safety messages may be found throughout this manual.

Related Documents
Additional information can be found in the following documents:

Related Documents for the MARS Ambulatory ECG System

Part Number Title

2083129–001 MARS V8 Ambulatory ECG System Pre-Installation Guide

2083129–002 MARS V8 Ambulatory ECG System Installation Guide

2083129–003 MARS V8 Ambulatory ECG System Operators Manual

2083129–005 MARS V8 Web Server Installation Manual

2083129–006 MARS V8 Web Client Manual

2083129–007 MARS V8 UNIX to PC Conversion Guide

Safety Information
The MARS Ambulatory ECG System is intended for use under the direct supervision of
a licensed health care practitioner.

CAUTION:
U.S. federal law restricts this device to sale by, or on the order of, a physician.

To ensure patient safety, use only software and accessories manufactured or
recommended by GE Healthcare. Contact GE Healthcare for information before
installing any software or connecting any accessories that are not recommended in
this manual.

CAUTION:
Installation of software or accessories not approved by GE Healthcare may
damage the system or cause the loss or corruption of data.
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Service Information
Customers are responsible for the maintenance and repair, including equipment
checkout, of the equipment on which they install the MARS Ambulatory ECG System.
GE Healthcare Service can assist in the reinstallation and configuration of the MARS
system as needed.

Regular maintenance, irrespective of usage, is essential to ensure that the MARS
Ambulatory ECG Standalone, Client, and Server are always functional when required.
Failure on the part of the responsible individual, hospital, or institution using the
MARS system to implement a satisfactory maintenance schedule may cause undue
equipment failure and possible health hazards. Customers who have upgraded
existing systems on legacy GE-supplied hardware should refer to the MARS Service
Manuals originally shipped with their product for information about the equipment,
preventive maintenance, and disaster recovery.

Identification
In addition to the software version, a copyright statement, and a prescription
statement, the MARS V8 Information screen displays two identifiers, as shown in the
following screen capture:

Identifier Description

Dongle Serial
Number

The dongle serial number uniquely identifies the dongle used to authenticate
the MARS V8 system. All software activation codes are linked to it, and it
must be present in order to install, restore, or use the system.

UDI The UDI (Unique Device Identification) uniquely identifies the MARS V8
medical device.

The UDI and Dongle Serial Number are both required when requesting service or
support.

To access the Information screen, select Help > About from the MARS V8 menu.

Security Updates
The GE Healthcare Product Security Database is a web portal to communicate
security-related information to customers. Access to the database is restricted to GE
Healthcare customers and requires a Single Sign On (SSO) account. If you do not have
an SSO account, you can sign up for one when you first access the portal.

The GE Healthcare Product Security Database contains information about security
patches from third-party vendors of software contained in GE Healthcare products.
This information includes the affected product and version, the patch identifier, the
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patch assessment date, the patch assessment status, and the patch assessment
details. When a patch has an approved status, you can download the patch from the
third-party vendor and install it on the identified product. The database does not
contain information about third-party patches that are not related to security.

The Product Security Database also allows access to Manufacturer’s Disclosure
Statement of Medical Device Security (MDS2) documents for GE Healthcare products.

To check on the latest information regarding validated security patches, do the
following:

1. Browse to the GE Healthcare Security web site:

http://prodsecdb.gehealthcare.com/

The GE Healthcare Single Sign On page opens.

2. Enter your SSO user ID and password and click Log In.

The Security page opens.

NOTE:
If you do not have an SSO account, click Sign Up and follow the instructions
to complete the registration for an SSO account. After the registration is
complete, the account is generated and the Security page opens.

3. Expand Product Security and select Product Vulnerability Database.

The Product Security Database page opens.

4. Search the Product Security Database for security patches approved for use
with your GE Healthcare product.

For more information, do any of the following:

• Review Getting Started at the bottom of the web page for a quick overview
of using the database.

• Select Help > FAQ at the top of the web page for frequently asked questions
about the database.

• Select Help > Training Document at the top of the web page for detailed
instructions on using the database.

2083129-004D MARS™ V8 19
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2
System Overview and Setup

This chapter provides a general overview of the MARS Ambulatory ECG System and its
set up procedure. For a detailed description of the MARS system, refer to the MARS V8
Pre-Installation Manual (2083129–001). For a detailed description of the installation
procedure, refer to the MARS V8 Installation and Upgrade Guide (2083129–002).

System Overview
The following sections provide an overview of MARS Ambulatory ECG System.

Intended Use
The MARS Holter Analysis Workstation is designed for the acquisition, analysis, edit,
review, report, and storage of ambulatory and multi-parameter ECG data.

Results of the automated analysis are intended to assist the physician in the
interpretation of the recorded data. This information is not intended to serve as a
substitute for the physician overread of the recorded ECG data.

The MARS system is intended to be used by trained operators under the direct
supervision of a licensed healthcare practitioner in a hospital or clinic environment.

Patient population includes both adult and pediatric (greater than 10Kg) human
patient.

The MARS system provides the user arrhythmia studies and Holter analysis capabilities.

Data acquired may be used for the following indications:

• Evaluation of symptoms that may be caused by cardiac arrhythmia and/or
conduction disturbances.

• Evaluation of symptoms that may be due to myocardial ischemia.

• Detection of ECG events that alter prognosis in certain forms of heart disease.

• Detection and analysis of pacemaker function and failure.

• Determination of cardiac response to lifestyle.

• Evaluation of therapeutic interventions

• Investigations in epidemiology and clinical trials.
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General Description
The MARS Ambulatory ECG System is a multi-parameter analysis and review
application that can be installed and run on customer-supplied systems that meet
the hardware and software specifications provided in the MARS V8 Pre-Installation
Manual (2083129–001).

System Configurations
The MARS application is available in three basic configurations designed to meet the
needs and budgets of different environments:

• Enterprise
Designed for large, multi-department environments, the Enterprise line offers
client/server systems that can acquire, analyze, review, and report on ECG data
across a network. The clients connect to a central server that stores all ECG data;
in the event the server is unavailable, the customer can store the data locally. In
addition, Enterprise models support third-party and external system interfaces.
Enterprise systems require a server and support up to 25 clients. Enterprise servers
cannot acquire or analyze ECG data.

• Department
Designed for small clinics or single-department environments, the Department line
offers client/server systems that acquire, analyze, review, and report on ECG data
across a network. The clients connect to a central server that stores all ECG data;
in the event the server is unavailable, the customer can store the data locally. In
addition, Department models support third-party and external system interfaces.
Department systems require a server and support from one (1) to five (5) clients.
Unlike Enterprise systems, the customers can set up the Department server as an
additional client and use it to acquire and analyze ECG data.

• Office
Designed for single-office environments, the Office line offers standalone systems
that acquire, analyze, review, and report on ECG data independently. They do not
connect with other MARS systems, so all data is stored locally. Customers can set
up Office models to print to any supported network printer and to store patient
reports on a MUSE system. However, they do not support interfaces to any other
third-party or external systems.
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Each configuration is available in multiple variations, each of which provides a
different set of features. The following table identifies the available configurations,
their variations, and their standard features. Availability differs by region. Consult
with your GE Healthcare sales representative for a list of configurations and features
available in your region.

Configuration Variations Standard Features

Enterprise Holter acquisition

Enterprise i Enterprise plus Monitoring Full Disclosure
acquisition

Department Core features

Department i Department plus Monitoring Full Disclosure
acquisition

Department Advanced
Core features plus ST Analysis, QT Analysis, HRV
Analysis, Waterfall Display, and MARS to MUSE
interface

Servers

Department Advanced I Department Advanced plus Monitoring Full
Disclosure acquisition

Office Core featuresStandalone

Office Advanced
Core features plus ST Analysis, QT Analysis, HRV
Analysis, Waterfall Display, and MARS to MUSE
interface

Client Core features

Client Advanced
Core features plus ST Analysis, QT Analysis, HRV
Analysis, Waterfall Display, and MARS to MUSE
interface

Client Outreach Acquisition and review only

Clients

Client CIC Acquisition and review of CARESCAPE CIC Pro or
CARESCAPE Central Station data only

The customer is responsible for providing hardware and operating system that meet
the MARS system requirements outlined in the MARS V8 Pre-Installation Manual
(2083129–001). Consult with your GE Healthcare sales representative for a list of
configurations currently available in your region.
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Supported Operating Systems
The following table provides a high-level overview of the supported operating systems.

Servers Clients /
Standalone

Windows Server 2008 (R2 SP1) (64-bit)1 Y Y

Windows Server 2008 (SP2) (32-bit)1 Y Y

Windows 7 (SP1) (64-bit) Y Y Y

Windows 7 (SP1) (32-bit) Y Y Y

Windows 8.1 (32–bit or 64–bit) Y

1 Running the MARS server on a virtual machine is supported only on Windows Server 2008
(R2 SP1) (64-bit). It is not supported on Windows Server 2008 (SP2) (32-bit).

For a complete list of the supported operating systems and ancillary software
components, refer to the MARS V8 Pre-Installation Manual (2083129–001).

Approved Software
The following software is approved for use on the MARS Ambulatory ECG System. The
addition of non-approved software programs is not recommended or supported
by GE Healthcare.

CAUTION:
DO NOT load any software other than that specified by GE Healthcare on the MARS
Ambulatory ECG System. Installation of software not specified by GE Healthcare
may damage the equipment or cause loss or corruption of data.

MARS Ambulatory ECG System Application
The MARS Ambulatory ECG System application acquires ECG data from electronic ECG
recorders and patient monitors. The software provides:

• Multiple techniques of scanning for complex editing.

• Algorithm enhancement for more precise beat and noise detection.

• Up to 12 high-resolution trends simultaneously on one screen.

• Pre-configured standard final reports.

• Dual channel superimposition displayed at up to 240 times real-time.

NOTE:
Depending on which features were purchased with your MARS Ambulatory ECG
System, you may need to use the MARS software activator to activate a feature
before you can use it. See the MARS V8 Operator’s Manual (2083129–003) for a list
of features that require activation and information on how to activate them.
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CardioSoft/CS Diagnostic System
The MARS Ambulatory ECG System is fully compatible with the CardioSoft/CS
Diagnostic Systems. CardioSoft/CS client software can operate on a MARS Ambulatory
ECG client or standalone workstation. The MARS Ambulatory ECG Server and
CardioSoft/CS Servers are qualified to operate simultaneously on the same computer.

NOTE:
You cannot install CardioSoft/CS client software and CardioSoft/CS server
simultaneously on the MARS Ambulatory ECG Server.

MARS Web Server
The MARS Web Upload Interface allows remote web clients to upload acquisition
information to the MARS server using the Internet (via secure VPN) or the hospital’s
intranet. The MARS Server and MARS Web Server are qualified to operate
simultaneously on the same computer.

InSite ExC
InSite ExC is a support application used by GE Healthcare to deploy remote services
over the Internet to equipment behind the customer’s firewall. It connects to the
customer’s existing outbound broadband Internet connection via a VPN tunnel, utilizes
128–bit Secure Socket Layer (SSL) encryption, and complies with existing firewall
rules and Web proxies.

Access to the system is restricted to authorized GE personnel only. To ensure that only
qualified and trained engineers can access the system, authorized GE Healthcare
users will be required to log on with user name and password authentication, and all
user and system interactions will be logged. GE Healthcare personnel comply with all
patient privacy regulations as defined by applicable government agencies.

To set up and configure the InSite ExC connection, the customer’s proxy server
information—such as IP address, port number, and authentication protocols— is
required.

Support for Virtual Machines
MARS servers and MARS Web servers can be run in virtual environments. However,
MARS clients, MARS Web clients, and standalone workstations cannot be run in virtual
environments; they must be run on physical PCs.

NOTE:
Do NOT install the MARS server on a virtual machine within the CARESCAPE
Information Exchange (IX) network. The MARS server can be installed on a virtual
machine only if it resides on the Enterprise network; the CARESCAPE IX network
does not support MARS servers that are installed on virtual machines.

GE Healthcare Service Responsibilities
GE Healthcare Service supports the MARS Holter system running on the Windows
operating systems as stated in this guide, regardless of whether that operating system
is installed on a physical or virtual machine. However, GE Healthcare does not provide
support for the installation or configuration of the virtual environment or for any
feature set provided as part of that environment, such as high availability, fail over
clusters, or SAN. To resolve issues specific to the virtual environment, the customer
must contact the virtual machine software’s vendor.
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GE Healthcare Service reserves the right to request the VM’s virtual hardware
configuration and to request the allocation of additional CPU cores or memory to
resolve performance-related issues.

Customer Responsibilities
Customers are responsible for the following when operating the MARS Holter system
in a virtual environment:

• Providing virtual machines (VMs) that meet or exceed the physical hardware
requirements for servers, as specified in the MARS V8 Pre-Installation Manual.

• Providing virtualization software that supports the MARS and MARS Web server
operating systems and service packs, as specified in “Supported Operating
Systems” on page 24.

• Providing a USB redirect application on virtual machines that house the MARS
server, to allow the server to access the USB dongle used to authenticate the MARS
system, as described in Appendix B, “Dongle Drivers”.

NOTE:
This is not required if the selected virtualization software natively supports
USB redirection.

• Completing the setup and configuration of the virtual machine(s) on which the
MARS server and/or MARS Web server will be installed prior to the arrival of the GE
Healthcare installation engineer.

System Setup
The following sections outline the basic procedure for setting up the MARS client-server
and standalone workstations. When necessary, you are instructed where to look for
additional information.

Verifying Appropriate Voltage
WARNING:

CURRENT LEAKAGE — Electrical shock could result from component failure and
lack of power isolation.

The MARS system is not intended for use in the patient vicinity. In the event
this system is used in the patient vicinity, it must be configured in such a way
that it and all of its electrically-connected peripheral devices are isolated from
mains power to prevent excessive leakage current to the patient. All non-medical
peripheral devices shall comply with IEC and ISO safety standards that are
relevant to that equipment (i.e., IEC 60950, UL 60950).

Use of the SEER Light Connect device in the patient vicinity requires that these
measures be observed.

To minimize the risk of current leakage and potential electric shock, do the following:

• Verify the voltage of the power source where the MARS Ambulatory ECG System will
be located is appropriate for your geographic area (115V or 230V) .

• Verify the PC on which you will install the MARS application is set for the correct
voltage.
The power supplies of some PC are equipped with a voltage switch that allows
users to toggle the power supply between 115V and 230V. If your system has such a
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power switch, confirm it is set to the correct voltage for your power source. Failure
to set the voltage switch to the proper input voltage may result in damage to the
unit when connected to a power source.
If your system does not have a voltage switch, verify in the manufacturer’s manual
that the power supply automatically detects the power line voltage before you
connect it to the power source.

Connecting the Equipment and Peripherals
Use the following guidelines for connecting the MARS System. Customers are
responsible for all hardware connections. The following connection guide provides
general information. For more detailed port and connection information, refer to the
manufacturer’s manual.

Configuration Interconnections

Device Connection

Keyboard and Mouse Connect to appropriate ports on the MARS workstation.

Monitor Connect to the appropriate video port on the MARS workstation.

Security Key (dongle) Connect to a USB port on the MARS workstation.
A Security Key is required for installation and use of the MARS
application.

NOTE:
If installing MARS on a virtual machine, the security key
drivers must be installed on the system where the key
physically resides. See Appendix B, “Dongle Drivers”, for
details.

SEER Light Connect or
SEER 1000 or
Multi-card Reader

Connect to a USB port on the MARS workstation.

Printer
• Connect to the appropriate connection (USB or parallel) on

the MARS workstation

• Connect to an AC power outlet.

Protecting Against Viruses
The customer is responsible for installing antivirus software if the MARS system will
be connected to a network. The software’s automatic protection option should be
enabled, and its virus definitions must be kept current. Discuss virus protection with
the hospital Information Systems (IS) department before installing the system on a
network.

Although GE does not provide antivirus software, the MARS system was tested with
Norton Antivirus Corporate Edition v10 and McAfee VirusScan Plus 2009. Other
antivirus products may be used, as long as they are qualified for the operating
system and service pack on which they are used. However, GE cannot guarantee full
compatibility with other antivirus programs and reserves the right to request that
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antivirus software be turned off as needed to troubleshoot or diagnose problems
affecting the MARS system.

NOTICE:
AVOIDANCE OF ERRORS — To avoid possible errors during the installation, disable
any antivirus software before starting the MARS Installation.
To avoid possible errors while using the MARS installation, configure your antivirus
software to exclude the following locations: C:\gemsit, its sub-folders, and your
archive target folders.

If your antivirus software supports the exclusion of processes—such as Microsoft
Forefront Client Security, Microsoft Forefront Endpoint Protection, Microsoft
Security Essentials, and Kaspersky Anti-Virus—configure it to exclude the following
processes:

• C:\gemsit\opt\MarsNT\bin\ekpro.exe

• C:\gemsit\opt\MarsNT\bin\ekpro_srvr.exe

• C:\gemsit\opt\MarsNT\bin\superapp.exe

Installing the MARS Application
After the equipment is connected and antivirus software installed, install the MARS
Ambulatory ECG System application.

If you are installing the application for the first time, or if you are upgrading an earlier
version of the application, refer to the MARS V8 Installation and Upgrade Guide
(2083129–002).

If you rebuilding an existing system, see Chapter 7, “System Rebuild”.

Connecting to the Network
After the MARS application has been installed, you are ready to connect the MARS
clients and servers to the network. For details, see Chapter 3 , “Network Setup”.

Verifying the Installation
The final step in setting up the MARS Ambulatory ECG System is to verify it was
installed correctly. For details, refer to “Verifying the Installation” in the MARS V8
Installation and Upgrade Guide (2083129–002). .
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This chapter describes the sharing and security settings created by default during the
MARS installation, explains how to add users to the default user group or how to add
the MARS system to an existing domain, and tells you on where to find instructions to
configure the MARS clients for connecting to the MARS server.

Folder Sharing and Security
During MARS installation, the following default accounts and folder shares are created:

Default Accounts

Account Type Account Name Description

GEService For GE remote support access (added to local
Administrators Group)Local Users

MUSEbkgnd For MARS to MUSE communication

Local User Groups MARSWORKGROUP Includes MARS users who require access to the
MARS folder shares

Default Folder Sharing and Security Permissions

Sharing Security
MARS
System Folder Group/Account Permissions Group/Account Permissions

\gemsit MARSWORKGROUP Full Control MARSWORKGROUP Full Control
Server

\gemsit\reports MUSEbkgnd Full Control MUSEbkgnd
MARSWORKGROUP Full Control

Standalone \gemsit\reports MUSEbkgnd Full Control MUSEbkgnd Full Control

NOTE:
For more information about the MUSEbkgnd account, see “The MARS to MUSE
Option” on page 36.
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Setting Up Client Network Access
In a client-server configuration, all MARS users logged in at a MARS workstation
require access to the \gemsit folder on the MARS server where the MARS slot and
report files are saved.

When configuring a client-server system, you need to perform two tasks to set up
network access on the client:

• Configure the OS network settings on the client and the server.

• Configure the MARS network settings on the client.

Configuring the OS Network Settings
The MARS installation program does two things to facilitate network access between
clients and server:

• On servers, clients, and standalone systems, it creates a Windows user group
named MARSWORKGROUP, which provides secure client access to the server's
drive share.

• On servers, it creates a drive share called x:\gemsit, where x: is the MARS
installation drive letter.
On a default installation, x is typically c:\. This drive share grants read, write, and
execute permissions to any member of the MARSKWORKGROUP, allowing the
clients to read and write patient data on the server.

In order to take advantage of the user group and drive share to allow clients to access
data on the server, all users of the client must be members of theMARSWORKGROUP
on both the client and server. There are two methods to achieve this:

• Manually adding users to the MARSKWORKGROUP on both the clients and the
servers.

• Joining the MARS system to a domain.

Both options are described in more detail in the following sections.

NOTE:
For maximum security, a third option is available: the customer can limit drive
share access by changing the share permissions for the \gemsit folder for
individual users rather than for the entire MARSWORKGROUP or domain.

Adding Users to MARSWORKGROUP
When you manually add a user to the MARSWORKGROUP on both the MARS client
and MARS server, the user name and password must match exactly on both systems.
Any discrepancy will prevent that user from accessing the data on the server.

This method is not as complicated as joining the MARS system to a domain, but it is
more labor intensive: it requires you to maintain users in multiple locations. Each
time you add or modify a user account on a client, you must add or modify the
corresponding account on the server.

Refer to the Windows documentation for instructions on how to add user accounts to
a user group. Apply all changes to both the client and the server.
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Joining the MARS System to a Domain
This method is more complicated than using the MARSWORKGROUP and local
accounts, but it is less labor intensive: it allows you to maintain users in a single
location—the domain controller. Any changes to user accounts on the domain
controller are reflected on both the server and all clients on the domain. It also
reduces the opportunity for conflicts between the clients and the server. The following
process assumes that the customer already has a domain controller on the network.

The process of joining the MARS system to a domain consists of the following general
tasks. Refer to the Windows documentation for detailed instructions for each task.
Work with the local system administrator to modify the site's domain controller as
necessary.

1. Add all MARS user accounts to the domain controller.
These users will be able to access any computer that allows access to the domain.

2. Add the MARS server and clients to the domain.
This allows any members of the domain to access both the client and the server.

NOTE:
You may also want to add standalone systems to the domain if you plan to
exchange information with a MUSE system.

3. Add all the MARS domain user accounts to the MARSWORKGROUP.
This user group has read-write permissions to the \gemsit shared folder.

4. Verify that users on the client can view, select, and edit patient records on the
server.
This confirms that the MARS system was successfully joined to the domain. Refer
to the MARS V8 Operators Manual (2083129–003) for instructions on how to view,
select, and edit patient records.

Configuring Network Settings on MARS Clients
MARS clients need to know the name or IP address of the MARS Server. This is
configured on each client. Refer to the MARS V8 Operator's Manual (2083129–003) for
more information on network setup for clients.

NOTE:
While you can configure a client for multiple MARS servers, it can only connect to
and display the information from one server at a time.
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Theory of Operation

This chapter describes the folders and services that are created when the MARS
application is installed and provides an overview of four optional features: MARS to
MUSE Communication, CIC Interface, andWeb Upload.

MARS Folder Structure
During the MARS installation, the installer creates the \gemsit folder on the selected
destination drive, typically drive c:. Within the \gemsit folder , the following
sub-folders are also created:

\Gemsit Folder Structure

Sub-Folder Description

AcqBackup Temporary folder used during acquisition/analysis to back up corrupt
files.

Idt Includes files needed to support MARS Web. For more information, see
“The Web Upload Option” on page 42.

Opt Holds the MARS Binary Application files.

reports Stores the MARS Holter Reports. For more information see “Reports
Folder” on page 34.

Scratch Holds a temporary copy of Slot File during analysis.

slots Stores patient Holter and monitoring data acquired by the MARS
System. For more information see “Slots Folder” on page 34.

var Stores MARS configuration, setup, and log files.

Xml Not currently used.
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Reports Folder
The \reports folder stores the Holter reports for all patients still active on the MARS
system. When a patient is deleted, any reports associated with that patient are also
deleted. The report folder is located at c:\gemsit\reports.

If purchased, the MARS to MUSE option can be used to permanently store reports
on a MUSE system.

Slots Folder
Slot files store the patient data acquired by the MARS system. Slot file sizes are
dynamic, with new slot files starting at 16 KB and growing in size to accommodate the
data being acquired. This differs from earlier versions of MARS, which used static slot
files sizes. The slot folder is located in c:\gemsit\slots.

Following is a list of slot file types and their associated file naming conventions:

Slot File Types and Names

Slot File Types Devices Acquired From Slot File Names

Acquired Monitoring Slot CIC (data analyzed by MARS) Acquiredslot0.h72c9.nat

Raw Monitoring Slot CIC (stored in its raw state) Monslot0.h72c.nrt

SEER Slot SEER 12, SEER Light, SEER Light
Extend, SEER MC, SEER 1000

Seerslot0.s48.nat

Tape Slot1 Tape Tapeslot0.h48c3.nat
1 Tape acquisition hardware is no longer supported, but you can import archived tape data into the MARS system.

On a MARS server or standalone system, the user selects the number and type of slots
they want to create during the MARS installation. The MARS installer limits the total
number of slot files you can create to 300. While the MARS system can accommodate
more than this number, the MARS user or administrator should be aware that a large
amount of slots can increase the amount of time it takes to display the Patient Select
List. This is more apparent on clients that must poll across the network to obtain the
Patient Select List from the server. To increase the number of slot files, or change the
slot file type after the initial installation, see Appendix A, “Slot File Tool User Guide”.

On MARS clients, 20 slots of each type are automatically created. The slot files on the
client are only used when connectivity to the MARS server is lost. This allows the user
to continue to acquire, store, and review data locally until connection to the server
is reestablished. Once the connection is restored, the user is prompted to transfer
the acquired data to the server.

The slot folder includes a diskman.dat file that contains an index of active slot files and
reports. Any time new patient data is acquired, a patient is deleted, or a Holter report is
saved, the system updates the diskman.dat file. Themars_creatediskmandat service
reads the diskman.dat file when the application starts, and intermittently thereafter,
and uses the information it contains to generate the MARS Patient Select List.

NOTE:
When patients are deleted from MARS, the system does not immediately delete
the information from the file. Instead, it marks the record as available in the
diskman.dat file. The system overwrites the record when new data is acquired.
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MARS Services
During the MARS installation, the following services are created:

MARS Services

Service Description Option Req'd Server Client Single

MARS.IDT.SlotFileCopier Checks for patient data that was
uploaded to the MARS Web server. Web Upload X

mars_cicbedsync Accesses the CARESCAPE IX network
to keep the list of selected beds
current in MARS.

CIC Interface X

mars_clientping Unlocks open patient files, if the
client using them goes down. X X

mars_creatediskmandat Initializes the patient list and
periodically updates to keep the
list current. This service runs once
upon system startup and then exits.
It is responsible for creating the
diskman.dat file.

X X

mars_EkproSvr Launches reanalysis of data when
requested by client. X X

mars_monacqmon Updates the ciclimit.ini file to
restore the correct MARS-CIC
acquisition entries in the event
the connection between the MARS
server and client fails.

CIC Interface X

mars_musesrvr Sends patient reports to a MUSE
system. MARS to MUSE X X

While all these services are created during initial installation, services that require the
purchase and activation of an optional feature (mars_musesvr, mars_cicbedsync,
mars_monacqmon, and MARS.IDT.SlotFileCopier) are initially stopped and their
startup type is set to Manual. Activation of an option in MARS starts its service and
changes its service startup type to Automatic.

For more information about the options associated with these services, refer to the
following topics:

• “The MARS to MUSE Option” on page 36

• “The CIC Interface Option” on page 36

• “The Web Upload Option” on page 42
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The MARS to MUSE Option
If you purchase the MARS to MUSE option, you can configure the MARS system to
save Holter records to a GE Healthcare MUSE system. This requires that the user
account configured to start the generacq service on the MUSE server have read and
write access to the \gemsit\reports share on the MARS server or standalone
workstation.

By default, theMUSEBkgnd account on the MARS server already has all the necessary
permissions to the \gemsit\reports share. The easiest way to grant the
appropriate permissions to the user account configured to start the MUSE generacq
service is to create a local account on the MUSE server with the same user name and
password as the MUSEBkgnd account on the MARS server.

If the account name or password is changed on either system, the MARS to MUSE
option will break. Therefore, it is necessary to duplicate any changes to the account
on both systems to ensure the option continues to work.

NOTE:
Do not modify the generacq logon account on the MUSE system to match the
MUSEBkgnd account on the MARS system. You must always modify the account
on the MARS system to match the account on the MUSE system.

If you choose to use a domain account for the MUSE generacq service instead, you
must ensure that the domain account has access to the \gemsit\reports share
(see “Folder Sharing and Security” on page 29).

The CIC Interface Option
The CIC Interface option allows the MARS system to acquire full disclosure (FD) data
from bedside monitors connected to the GE Healthcare CARESCAPE Monitoring
Network. The data collected from the bedside monitors are stored on a Central
Information Center (CIC) that resides on the CARESCAPE Information Exchange (IX)
network. Multiple CICs may reside on the same IX network.

Following is an overview of the MARS-CIC work flow:

1. The MARS client requests a list of available beds from a CIC.

2. On the MARS client, the user selects from the list which beds to monitor.

3. The MARS client’smars_cicbedsync service polls the CIC at regular intervals for
patient information and available FD data for the selected beds.

4. On the MARS client, the user selects the bed(s) from which to acquire data.

5. The MARS client requests the FD data from the CIC where the data is stored.

6. The CIC transfers the stored FD data to the MARS client.

7. The MARS client temporarily stores and compresses the FD data.

8. The MARS client transfers the compressed FD data file to the MARS server, where
it is available for review by all MARS clients.

The following sections provide more detail about the CIC Interface requirements,
network connectivity, and restrictions.
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Requirements for Using the CIC Interface
Before you can use the CIC Interface, certain requirements must be met by both the
CIC and MARS systems.

The following requirements must be met by each CIC that will provide FD data to
the MARS system:

• It must be a CIC Pro V5.1 or CARESCAPE Central Station V1.

• It must be licensed for full disclosure.

• It must have at least 10 minutes of stored FD data.

For more information, refer to the documentation that accompanied your CIC Pro
or CARESCAPE Central Station system.

The following requirements must be met by each MARS client that will acquire FD
data from the CIC:

• The client must have adequate disk space for the volume of FD data to be acquired.
When the client downloads FD data, it temporarily compresses and stores the files
locally before uploading them to the server. The client must have adequate free
space for that data. For more information about the size of FD data files and their
compression ratio, see “Data File Sizes” on page 37.

• The client must be connected to the CARESCAPE IX network.
You have two options for connecting the MARS client to the CARESCAPE IX network.
See “Network Connectivity” on page 37 for a description of each option.

• The CIC Interface option must be activated and configured on the client.
This enables the client to begin acquiring FD data from the CIC. For more
information, see “Activating and Configuring the CIC Interface” on page 38.

Data File Sizes
Full Disclosure data file size varies depending on the number of channels and the
number of hours acquired. On the CIC, a full 76–hour FD data file can be 1.0 to 1.5 GB,
while a 24–hour FD data file is approximately one-third that size at 341 to 512 MB.

When MARS client acquires FD data from the CIC, it compresses the file and stores it in
the MARS Slot File folder on the MARS server. While the amount of the compression
varies depending on the quality and consistency of the data, it is approximately
one-half the original file size. So, the storage requirements would range from
approximately from 170–256 MB for a 24–hour record to 512–768 MB for a 76–hour
record. Keep that in mind when sizing your disk drive.

Network Connectivity
The MARS clients that acquire data from the CIC can reside on either the hospital’s
Enterprise Network or on the CARESCAPE IX network.

• MARS clients on the CARESCAPE IX network
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Clients on the IX network can communicate directly to the CIC, but they require
a router to communicate to the MARS server, which is typically installed on the
Hospital Enterprise Network. Data transfer on this network consists of:

• FD data transferred from the CIC(s) to the MARS client over the IX network.

• Acquired data transferred from the MARS client through the router to the MARS
sever on the Enterprise network.

• MARS clients on hospital’s Enterprise network
Clients on the Enterprise network can communicate directly to the MARS server, but
they require a router to communicate to the CIC on the IX network. Data transfer on
the network consists of:

• FD data transferred from the CIC on the IX network through a router to the MARS
client on the Enterprise network.

• Acquired data transferred from the MARS client to the MARS server across the
Enterprise network.

MARS workstations requiring router access to either the IX network or the MARS server
need a default gateway address and subnet mask assigned, depending on how the
network design is implemented. For example, if the MARS workstation is on the IX
network, it needs access to the MARS server on the Enterprise network, and the MARS
server on the Enterprise network needs access to the MARS workstation on the IX
network. This is shown in the following diagram:

In this example, the MARS client requires a default IP address for Gateway 1 and the
MARS server requires a default address for Gateway 2.

Activating and Configuring the CIC Interface
Activating the CIC Interface option is done on the System: Software Activator Setup
window and enables the CIC services that were installed with the MARS application.
Configuring the CIC Interface option is done on the System: CIC Configuration
window and identifies the IP addresses of the CICs and MARS servers with which the
MARS client will communicate. For information on both processes, refer to the MARS
V8 Operator’s Manual (2083129–003).
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Description of the CIC Services and Files
After the CIC Interface is activated and configured, it uses several files and services to
initiate and track communication with the CIC. The following table provides additional
information about those files and services:

Item Description

Primary MARS server The MARS server that contains the ciclimit.ini file. Only one
primary server can exist .

Secondary MARS server Any MARS server not designated as primary. Secondary
servers contain the cic.ini file. Any number of servers may
be designated as secondary.

ciclimit.ini Stored on the primary MARS server, this file contains
information about the MARS clients currently connected to
each CIC. This file is automatically updated as connections
open and close. Following is an example of an entry in the
file:
3.62.121.1 = “MARSCLIENT02” “MARSCLIENT03”
“MARSCLIENT05”

This entry indicates that three MARS clients (MARSCLIENT02,
MARSCLIENT03, and MARSCLIENT05) are connected to the
CIC at 3.62.121.1.

NOTE:
If the connection between a MARS client and the server
is lost, the client will not be able to access this file. In this
case, the client will not be able to initiate communication
with the CIC until the connection with the server is
reestablished. If a download is in process when the
connection is lost, the data will be stored locally on the
client.

cic.ini Stored on each secondary MARS server, this file contains
an entry labeled CIC_PrimaryServer, which the secondary
servers use to identify the IP address of the primary MARS
server so they can locate the ciclimit.ini file.

NOTE:
This information is entered via the System: CIC
Configuration window within the MARS application.
Manual entry of data in this file is not needed or
recommended.
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Item Description

mars_cicbedsync This service is installed on each MARS client that acquires
data from a CIC. It polls the CIC on the IX network using
Port 9001 at regular intervals and returns the following
information for all beds with available FD data on the
Selected Bed List :
• Name of care unit

• Bed number

• Patient name

• Patient ID

• Start time (start of available FD data)

• End time (end of available FD data)

• Status (admitted or discharged)

Beds with no available FD information are not displayed in
the MARS system.

mars_monacqmon This service is installed on each MARS client that acquires
data from a CIC. It periodically determines whether the client
is connected to a CIC and either adds or deletes an entry
in the ciclimit.ini file as necessary to ensure that the file
accurately reflects the current CIC connection status.
For information on configuring this service, refer to
“Configuring the CIC Monitoring Service”.

Configuring the CIC Monitoring Service
When you activate the CIC Interface, themars_monacqmon service is set to start
automatically. By default, the service runs using the Local Service account. Because
the service monitors connections between the MARS clients and CICs and updates the
ciclimit.ini file, the service must be modified to run using an account with read and
write access to the network share where the ciclimit.ini file is located.

The following procedure must be performed on each MARS client that will be set
up to acquire FD data.

1. From the system desktop, select Start > Run.

The Run dialog box opens.

2. Type services.msc and press Enter.

The Services window opens.

3. Locate themars_monacqmon service, right-click on it, and select Properties
from the popup menu.

The MARS_MONACQMON Properties dialog box opens.

4. Select the Log On tab.

5. Select the This Account radio button and enter the name and password of the
account this service should use to log on.

The logon account must be a user with Full Control permissions under both
the Sharing and Security tabs for the \gemsit folder share on the MARS
server. Any account can be used, including a domain account, as long as the
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correct permissions have been set and the account and password exist on
both the client and the server. It is recommended that the same account used
by the mars_monacqmon service on all clients and that it be added to the
MARSWORKGROUP user group on the MARS server. During installation, the
MARSWORKGROUP user group is given the correct permissions to the \gemsit
folder share.

6. After you enter the user name and password, click OK.

7. Click OK for any messages that open.

8. Restart the system.

9. Configure the MARS clients.

Refer to the MARS V8 System Operator's Manual (2083129–003) for information
on configuring the clients.

CIC Performance
Excessive connections between MARS clients and a single CIC unit could potentially
affect the performance of the CIC unit. Therefore, the MARS system implements two
methods to limit a negative impact on CIC performance.

CAUTION:
GE Healthcare provides network services to recommend an appropriate network
design to ensure the performance of the IX network and the CIC. DO NOT connect
additional MARS clients to the IX network without first reviewing their impact to
network and CIC performance with GE Healthcare.

CIC Connection Limits
The CIC Interface limits the number of concurrent connections: no more than three
(3) MARS clients can connect to a single CIC unit concurrently. Before a MARS client
can initiate a download from a CIC, it must verify that it will not exceed the maximum
number of connections for that CIC.

To monitor these connections, the MARS system uses a file called ciclimit.ini,
located in the \gemsit\var\MarsNT\system directory on the MARS server. For large
installation with multiple servers, one is designated as the primary server and the rest
are designated as secondary servers. The ciclimit.ini file is stored only on the primary
MARS server; the secondary servers contain a file called cic.ini, which identifies the IP
address of the primary server.

Before a MARS client acquires data from a CIC, it opens the ciclimit.ini file and counts
the number of MARS clients already connected to the CIC. If the number of connected
clients is already at the limit, a message displays on the client indicating that the limit
has been reached. If the number of connected clients does not exceed the limit, the
client adds its name to the entry for that CIC and begins the download. When the
download is complete, the MARS client opens the ciclimitl.ini file and removes its
name from the entry for that CIC to free up that CIC for another connection.

If the connection between a MARS client and server is lost, the MARS client will not be
able to update its entry in the ciclimit.ini file. To correct this, themars_monacqmon
service runs periodically on each client and updates the ciclimit.ini file appropriately
when the client/server connection is restored.

2083129-004D MARS™ V8 41



Theory of Operation

Network Usage
In addition to limiting the number of concurrent MARS connections to a single CIC, the
CIC Interface also controls the flow of FD data to connected MARS clients.

If multiple beds are selected for acquisition from a single MARS client, the data is
acquired sequentially. That is, the second bed is not acquired until the first bed
completes. While network usage is longer, the amount of network bandwidth used
is the same as a single bed acquisition.

If two or more MARS clients are acquiring bed data from different CICs at the same
time, the data is acquired simultaneously. This uses a larger amount of network
bandwidth than acquiring from a single CIC.

Due to the large size of FD files being transmitted, if more than one MARS workstation
is accessing the IX network at the same time, network switches, routers, and trunks
must be sized correctly to handle the additional traffic.

The Web Upload Option
TheWeb Upload Interface is a MARS option that allows remote clients to acquire Holter
data and upload it to a central MARS Web Server. When the MARS Server detects new
Holter data on the MARS Web Server, it copies the data for analysis, reporting, and
archiving. The MARS Web Upload Interface is intended to be used by facilities that do
not have the personnel, resources, or budget to conduct their own data analysis.

The following sections provide a high-level overview or the MARS Web Upload Option.
For detailed installation instruction, operating instructions, and troubleshooting
assistance, , refer to the MARS V8 Web Server Installation Manual (2083129–005) and
MARS V8 Web Client Operator Manual (2083129–006).

MARS Web Upload Components
The MARS Web Upload Interface consists of three main components, each of which
perform a different step in the process:

1. MARS Web Client: Acquires data at the user PC and transmits data to the MARS
Web Server.

2. MARS Web Server: Receives data from the user PC.

3. MARS Server: Copies data from the MARS Web Server to the MARS Server.

NOTE:
The MARS Web server can be physically installed on the same PC on the
MARS server.
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The following diagram shows the high level data flow from the MARS Web client to
MARS server.

The following information discusses each component in more detail. GE Healthcare
recommends keeping default folders and ports to avoid adding complexity to the flow
of data. Using the default settings simplifies troubleshooting and reduces service calls.

MARS Web Client
The MARS Web Client acquires data at the user’s PC and transmits it to the
MARS Web Server. Data acquired at the user PC is stored in a local folder
specified in the Web Client settings on the PC. The default local folder is
c:\gemsit\idt\var\acquireddata. This is created the first time the Web
Client acquires Holter data. After the Web Client successfully acquires the data, it is
compressed to reduce transmission times when uploaded to the Web Server.

Each Web Client must specify:

• IP address of the MARS Web server

• Server port to use for the MARS Web server (default 8089)

NOTE:
The server port specified on the Web Client is for data transmission only. The
port that establishes the initial communication between the client and Web
server is port 80.

• Archive folder path where the data files are stored locally (default acquired data)

MARS Web Server
The MARS Web Server temporarily holds the Holter data transmitted by the MARS Web
Client. By default, the files are transmitted using port 8089.

NOTE:
If you change this port, you must reconfigure it on the MARS Web server and each
Web client. Refer to the MARS V8 Web Server Installation Manual (2083129–005)
for details.

Uploaded files are stored temporarily to a folder location identified as the
ArchiveFolderPath, which is in c:\gemsit\idt\var\IISServerData by
default. The default location can be changed by modifying the holterstream.ini
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file, which is located in c:\gemsit\var\MarsNt\idt_config on the MARS
Web server.

NOTE:
Due to the way the MARS system parses the folder path, the path
must be entered using double slashes (\\) in place of a single
slash (\). For example, in the Holerstream.ini file, you must
enter the path c:\gemsit\idt\var\IISServerData as
“c:\\gemsit\\idt\\var\\IISServerData” (including the quotation
marks). This same pattern occurs in other places in the MARS system.

MARS Server
The MARS Server uses the MARS.IDT.SlotFileCopier service to move the Holter data
from the MARS Web Server and make it available for review and analysis on the MARS
system. For details, refer to “Slot File Copier” on page 44.

Data successfully moved to the MARS Server is automatically deleted from the Web
Server. If an open slot file is available on the MARS server, the data is moved from the
MARSServerData folder and placed into the open file. If no slot files are open, the file
remains in the MARSServerData folder and the display for theWeb Alert icon that
displays on each MARS client is changed to notify the user that there are pending files
waiting for an open slot file. Once a slot becomes available, the file is automatically
moved to the open slot file and deleted from the temporary folder.

MARS Web Upload Services and Files
The MARS Web Upload option uses a couple of services and an ini file to control the
communication between the MARS Web Client, MARS Web Server, and MARS Server.

Slot File Copier
The MARS Server uses the MARS.IDT.SlotFileCopier service to periodically
poll the IISServerData folder on the MARS Web Server for new Holter data.
When it finds new data, it copies the record to a temporary file located at
\gemsit\idt\var\MarsServerData on the MARS Server. If there are available
slots, it then moves the Holter data to the available slot and deletes both the
temporary records on the MARS server and the MARS Web Server.

To determine the location of the MARS Web Server, the path and name of the folder
where the Holter records are stored, the MARS.IDT.SlotFileCopier service reads the
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values stored in \gemsit\var\MarsNT\idt_config\SlotFileCopier.ini
on the MARS server.

The following table identifies the default values in the .ini file. The file can be modified
as appropriate.

SlotFileCopier.ini File

Variable Name Default Value Description

Webslotpath IISServerData The name of the folder on the MARS
Web Server used to temporarily store the
uploaded data files from the Client.
IISServerData is the default and you
usually do not need to change it.

TempFolderPath c:\\gemsit\\idt\\var\\
MarsServerData

The path to the folder that temporarily
stores the data files that copied from the
Web Server to the MARS Server.
MarsServerData usually does not need to
change.

IISServerName 127.0.0.1 The IP address of the MARS Web Server.
If the MARS Web Server is on the same
server as MARS, you can use the default IP
address. If it is on a separate server, you
must enter the correct IP address.

NOTE:
If you modify the default values, you must enclose all values in quote marks ('").

TheMARS.IDT.SlotFileCopier service must have full permission to move data from the
IISServerData folder on the MARS Web Server.

One way to do this is to assign the GEService account as the logon account for the
MARS.IDT.SlotFileCopier service on the MARS server . You must also duplicate the
account on the MARS Web Server and assign Full Control permissions for Sharing
and Security to the IISServerData folder. Changing the account or password in one
location requires changing it in the other.

If you choose to use a domain account as the logon account for the
MARS.IDT.SlotFileCopier service and the IISServerData folder share, assign account
administrator privileges to the MARS server.

MARS.IDT.RemotingService
While the MARS.IDT.SlotFileCopier service controls communication between the
MARS Server and MARS Web Server, MARS.IDT.RemotingService, which is installed
on the MARS Web Server during installation, handles logon and communication
between the MARS Web Client and the MARS Web Server. Configuration of
MARS.IDT.RemotingService is automatic and does not require manual intervention.
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MARS Web Alert
The MARS Web Upload uses the Web Alert icon to notify users when Web Upload files
are waiting for an open slot file.

For the MARS Web Alert icon to display correctly, MARS users must have permissions
to the c:\gems\it\var\MarsServerData folder on the MARS server. To do this,
share the MarsServerData folder and assign the MARSWORKGROUP full control
permissions for sharing and security.
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A regular preventative maintenance program helps prevent unnecessary equipment
and power failures and reduces possible health hazards. Because the customer
owns the equipment on which the MARS Ambulatory ECG system resides, the sole
responsibility for establishing and executing said maintenance program rests with the
individual or institution using the equipment.

While the customer should refer to the manuals that accompanied their equipment
for details, GE Healthcare recommends that the maintenance routine include the
following:

• Visual inspection of the equipment for damage

• Cleaning the cooling fans and ventilation obstructions

• Cleaning the exterior and interior of the equipment

• Cleaning the equipment’s peripherals, such as keyboard and monitors

Typically, these maintenance activities are performed annually and whenever internal
assemblies are serviced.

NOTE:
Customers who upgraded legacy, GE-supplied hardware should refer to the
documentation that accompanied the original equipment for maintenance
information.

Backing Up and Storing Data
Before performing any service on the MARS Ambulatory ECG System or its
components, it is recommended that you back up patient data and system
configuration. This section describes how to archive Holter data, how to back up
Holter data, and how to back up the system configuration.

Archiving Data
MARS is not intended for long term storage and provides two methods for saving data.
It is highly recommended that MARS users establish a formal schedule or process to
ensure data is archived or saved on a regular basis to limit loss of data in the event
of a hard drive failure. Data and reports should be archived or saved as soon as
possible after completing the analysis and creating the report to limit any exposure
of the data to a system failure.
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Use one of the following methods to save and store reports and data.

• MARS Archive
MARS provides an archive feature that allows you to save both Holter reports and
Holter data to a CD, DVD, USB drive, or network share. Once archived, you can
delete the report or data file from the MARS system. You can restore archived
reports and data to the MARS system from the storage location. If you are saving to
a network share, MARS users must have read and write permissions to it.
Archives on network and local drives are limited to a maximum of 5000 records,
regardless of available space on the drives. Once your system reaches this limit,
you need to specify a new archive location before you can archive additional
patient records. Each archive folder creates its own index file, which is updated
each time a new report or slot file is archived.

NOTE:
The Archive and Restore from Archive features are described in the MARS
V8 Operator’s Manual (2083129–003).

• MARS to MUSE
Customers who have activated the MARS to MUSE option (see “The MARS to MUSE
Option” on page 36) can store final Holter reports to a GE Healthcare MUSE system .
Once the MARS reports are stored on the MUSE system, the Holter report can be
viewed and printed from any MUSE client and is backed up as part of the MUSE
database. The MUSE system does not store the raw Holter data. To store raw Holter
data, you must use the MARS archive process.
MARS to MUSE requires installation of the MARS print formatter on the MUSE
system in order to print full Holter Reports. In addition, the MUSE system must have
read/write permissions to the \gemsit\reports folder on the MARS system.
Contact GE Healthcare Technical Support or the local MUSE administrator for more
information.

Backing Up Holter Data
Newly acquired data reside in slot files on the MARS server or MARS standalone
system until it is archived. During this time the data and reports are stored locally and
can be lost if the system fails. Customers concerned about data loss during this time
should consider using a system with additional fault tolerance, such as RAID, to limit
loss of data due to a single hard drive failure.

To back up Holter records, you need to back up the following folders:

• C:\gemsit\reports

• C:\gemsit\slots

NOTE:
Establishing a regular backup schedule is the customer's responsibility. You may
use any backup utility in place at the customer site, as long you can restore the
reports and slots folders on the MARS system when needed.
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Backing Up the System Configuration
You should backup system setups after making a change to any item listed in the
System > System Setup menu. Use the following procedure to back up the MARS
system’s setup files.

1. From the top menu in MARS, select System > System Setup > Backup and
Restore.

2. Enter a name for the backup file and browse to the path where you want to
store the backup file.

If you are saving to a network drive, map the drive share on the MARS system
first so it is available in the list.

Additional instructions are included in the MARS V8 Operator’s Manual
(2083129–003).

To restore the system setups, follow instructions included in the MARS V8 Operator's
Manual (2083129–003).

Safe Shutdown Procedures
Before performing any maintenance or replacing any peripherals, it is recommended
that the computer hosting the MARS application be shut down. The following
procedures describes how to shut down the system in a safe and controlled manner.

Shutting Down a MARS Client or Standalone Workstation
1. Close all patient tests.

2. Exit the MARS application.

3. Close any open browser windows or other applications.

4. Shut down the Windows operating system.

Depending on the configuration, shutting down the operating system typically
turns off the equipment automatically.

Shutting Down a MARS Server
1. Before shutting down the MARS server, notify all MARS users of the scheduled

shutdown.

2. Request users to close any open patient tests they are accessing on the MARS
server.

NOTE:
Clients can continue to acquire data while the server is shutdown. Any newly
acquired tests are stored locally on the client. As soon as the connection
to the MARS server is re-established, any locally stored test is moved to
the MARS server.

3. Exit the MARS application.
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4. Close any open browser windows or other applications.

5. Shut down the Windows operating system.

Depending on the configuration, shutting down the operating system typically
turns off the equipment automatically.

Checkout Procedures
Use the following checkout procedures as appropriate. For detailed instructions for
performing any of the functional tasks (such as acquiring data, selecting patients, and
so forth) refer to the MARS V8 Operator's Manual (2083128–003).

Visual Inspection
Before performing any functional checkout, conduct a thorough visual inspection for
the following:

• Signs of cracks or any other visual damage to the case or monitor.

• Signs of fraying or damage to cords and cables.

• Bent prongs or pins in plugs, cables, and connectors.

• Secure seating of all cords, socketed components, and connectors.

If system was opened, you should also verify that the interior is free of excessive dust
buildup. If necessary, use commercially available compressed air to clean, following
manufacturer's instructions.

Acquisition Device Checkout Procedures
Whenever an acquisition device is added, replaced, or repaired, the checkout
procedure appropriate for that device should be performed:

Acquisition Device Checkout Procedures

Device Checkout Procedures

Multimedia Card Reader
(external)

Multimedia Card Reader (See “Multimedia Card Reader” on
page 50.)

OmniDrive (external) OmniDrive (See “OmniDrive” on page 51.)

SEER LT Recorder (external) SEER LT Recorder (See “SEER LT Recorder” on page 51.)

SEER 12 Recorder (external) SEER 12 (See “SEER 12” on page 51.)

SEER 1000 Recorder
(external)

SEER 1000 (See “SEER 1000” on page 51.)

SEER MC Recorder (external) SEER MC (See “SEER MC” on page 51.)

Multimedia Card Reader
1. Insert a CompactFlash card and verify that the system recognizes it.

2. Confirm that you can view the contents of the card.

3. Confirm that you can open files from and save files to the card.

4. Confirm that you can acquire data into the MARS system from the card.
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OmniDrive
1. Insert the card and verify that the Download screen opens.

2. Select Start.

3. Verify that the download completes.

SEER LT Recorder
1. Insert the card and click on the Acquire Data icon.

2. Verify that the Download screen opens.

3. Select Start.

4. Verify that the download completes.

SEER 12
1. Insert the card and click on the Acquire Data icon.

2. Verify that the Download screen opens.

3. Select Start.

4. Verify that the download completes.

SEER 1000
1. Connect SEER 1000 recorder to the MARS workstation using the USB cable.

2. Press the Acquire Data icon.

3. Verify that the Download screen opens.

4. Select Start.

5. Verify that the download completes.

SEER MC
1. Insert the card and click on the Acquire Data icon.

2. Verify that the Download screen opens.

3. Select Start.

4. Verify that the download completes.

System Checkout Procedures
A complete system functional checkout is required for non-FRU repairs and typically
involve MARS setup and tasks that can be performed remotely or onsite. If performed
remotely, the remote support engineer can confirm via remote access, or verify with
the customer contact. For additional instructions, refer to the MARS V8 Operator's
Manual (2083129–003).

Certain checkout procedures are performed only if the corresponding peripheral or
option is present and activated.
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Acquiring Data From SEER Card
1. Insert the card and click on the Acquire Data icon.

2. Verify that the Download screen opens.

3. Select Start.

4. Verify the download completes.

Acquiring Data from CIC
1. Open Patient Select.

2. Choose Select Beds from the Data Types.

3. Select a patient bed with full disclosure information available.

4. Click Acquire Data.

5. Verify that the monitoring data is acquired and displayed on the Patient List
when complete.

Acquiring Data via MARS Web
1. Log on to the MARS Web Server from a Web Client.

2. Acquire data at the client.

3. Verify that the data is acquired on the client.

4. Verify that you can upload the acquired data from the client to the Web Server.

5. Verify that you can see the acquired data from a MARS workstation.

Transmitting to MUSE
1. Select the patient, select the tools, and then transmit to the MUSE system.

2. Verify data is transmitted to the MUSE system.

Archiving
1. Select the patient, go to Tools, and select Archive.

2. Select the patient and choose Restore.

3. Verify the patient is restored to the Patient Select screen.

Login
1. Have the user log on to the MARS system.

2. Verify the user is successfully able to log on.

Printing
1. Select a patient.

2. Select Page Review and select Print.

3. Verify the strip prints.
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Selecting Patient Data from a Remote MARS
1. Go to Data Type and ensure that another MARS system is listed.

2. Verify remote MARS patient data is available in Patient Select.

Editing
1. Select a patient.

2. Verify you can edit the data.

Connecting Remotely
Use the following procedure to verify the system can be accessed for remote support.

1. Log on to the system using the remote configuration configured for that system
(InSite ExC).

2. Confirm that you can access the customer’s desktop via the remote connection.

Time Changes
MARS workstations not being used to acquire FD data from the CIC have no special
date/time constraints. You can adjust Daylight Savings Time (DST) using the Windows
Automatic DST function or you can manually adjust it twice a year, depending on
customer preference.

Ideally, MARS workstations communicating with the Carescape IX network, for the
purpose of acquiring FD information from the CIC, should have their time\date setting
adjusted at the same time as the CIC's to ensure the time stamp on the data received
from the CIC and displayed on MARS is the same.

There are three possible time settings/services that could cause the MARS time\date
settings to change, independent of the CIC time setting:

• Windows Automatic DST setting

• Windows Time service

• Internet Time Sync

The user should be aware that any of the above automatically adjusts the time on
the MARS workstation during DST and could cause the time on the CIC and MARS to
differ by one hour until both the CIC and MARS daylight saving time adjustments are
complete. If both DST adjustments are made during off peak hours, when you are not
using MARS for FD acquisition, this may not present any noticeable timing issues.

Consult with your IT department or network administrator to determine if you should
disable any of the above settings\services on the MARS workstation you are using
for FD acquisition.
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Troubleshooting

This chapter provides information to help you isolate, identify, and resolve problems
with the MARS system, moving from the general to the specific.

NOTE:
If you cannot resolve an issue using the information in this chapter, contact
technical support for additional assistance.

Initial Questions
If the MARS application is not working properly, start by asking yourself these basic
questions to help narrow the cause of the problem.

• Are the unit and all peripherals turned on and connected?
If any system component is not turned on or properly connected, correct the
condition to see if that resolves the problem.

• Have there been any changes in the use, location, or environment of the equipment
that could cause the failure?
For example, has the equipment been moved to a location with an inadequate
power source? If so, return the equipment to its original location to see if that
resolves the problem.

• Has the unit been modified in any way, either in software or hardware?
For example, has any unapproved, third-part software been installed on the
system? If so, uninstall the software to see if that resolves the problem.

• Is operator error the cause of the problem?
Try to repeat the user’s scenario exactly and compare the process and results to the
proper operation of the equipment as described in the system’s operator’s manual.

Visual Equipment Inspection
If running through the initial questions does not help resolve your problem, the next
step is to visually inspect the equipment.

A thorough visual inspection of the equipment can save time. Small
things—disconnected cables, foreign debris on circuit boards, missing hardware,
loose components—can frequently cause symptoms and equipment failures that may
appear to be unrelated and difficult to track.
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Take the time to make all the recommended visual checks identified in the following
visual inspection chart before starting any detailed troubleshooting procedures. If a
failure condition is identified, that condition should be corrected before the user of
the MARS system is resumed.

NOTE:
The following list of visual checks is provided as a guideline. Because customers
own the equipment on which they installed the MARS application, they are
responsible for the maintenance and troubleshooting of all hardware. Before
performing any visual inspection of the equipment, the customer should be sure
to review, understand, and follow any technical instructions that accompanied the
equipment. For legacy systems that include GE-supplied hardware, customers
should review the service manual that accompanied the legacy system for
platform specific information.

Visual Inspection List

Area Look for the following problems:

I/O Connectors
and Cables • Fraying or other damage

• Bent prongs or pins

• Cracked housing

• Loose screws in plugs

Interface Cables • Excessive tension or wear

• Loose connection

• Strain reliefs out of place

Circuit Boards • Moisture, dust, or debris (top and bottom)

• Loose or missing components

• Burn damage or smell of over-heated components

• Socketed components not firmly seated

• PCB not seated properly in edge connectors

• Solder problems: cracks, splashes on board, incomplete
feed-through, prior modifications or repairs

Ground Wires/
Wiring • Loose wires or ground strap connections

• Faulty wiring

• Wires pinched or in vulnerable position

Mounting
Hardware

Loose or missing screws or other hardware, especially fasteners used
as connections to ground panes on PCBs

Power Source
• Faulty wiring, especially AC outlet

• Circuit not dedicated to system

(Power source problems can cause static discharge, resetting problems,
and noise.)
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Log File Review
If visual inspection of the equipment did not isolate the cause of the problem, the next
step would be to review the system’s log files to identify both the exact point the error
occurred and the conditions that led to the error. The MARS system provides several
log files to record a variety of transactions. Understanding what each log file records
will help you identify which log file to review. For example, if you encounter an issue
during installation, you would want to review the installation log.

The following sections describe the log files found on the MARS server and client, the
MARS Web Client, and the MARS Web Server.

MARS Server and Client
The following table defines the files that are found atc:\gemsit\var\MarsNT\log
on the MARS server and client.

MARS Server and Client Log Files

Log File Purpose

SlotFileCopier.log Records activity between the slotfilescopier service and the Web
Server.

SlotFileUtilErrLog.log Records activity on the uploaded slot files on the MARS server.

Scribe.log1 Logs acquisition, analysis (ekpro) and file transfer of CIC data.

BedSync.log1 Logsmars_cicbedsync service operation.

MARS_install_eng1 MARS installation log in English.

MARS _install_sel1 MARS installation log in the selected language.
1 These log files are located on both the MARS server and client.

MARS Web Client
The following table defines the log files that are found at c:\gemsit\idt\var\log
on the MARS Web Client.

MARS Web Client Log Files

Log File Purpose

Devmgrerrlogger.log Records communications between the MARS Web client and
the Holter device.

Webclientui.log Records activity occurring on the Web Client.
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MARS Web Server
The following table defines the log file that is found at c:\gemsit\idt\var\log
on the MARS Web Server.

MARS Web Server Log File

Log File Purpose

MarsHHTPSRemotingService Records data upload transactions.

Specific Errors
The following sections list specific error conditions that have been identified for some
optional MARS features. For each error condition, possible causes have been identified.

Specific MARS Web Upload Error Conditions
The following table lists some specific error conditions that have been identified with
the MARS Web Upload option. For more detailed information, refer to the MARS V8
Web Server Installation Manual (2083129–005) and the MARS V8 Web Client Operator’s
Manual (2083129–006).

MARS Web Upload Errors

Problem Possible Causes

User cannot log on • User using wrong logon account or password.

• User not set up in User List on MARS Web Server.

• User not specifying web server port in URL, if other than 80.

• User is using their Windows domain account to log on under
Forms Authentication.

• The Default Web Site on the Web Server stopped.

• TheMARS.IDT.RemotingService on the Web Server stopped.

• The Network Service account does not have permission to the
gemsit folder on the Web Server.

• The correct version of ASP.NET (v1.1.4322) is not registered on
the MARS Web Server.

Client software does
not install • .NET Framework was not installed.

• User does not have rights to install new software.

• An earlier version of MARS Web Client was not uninstalled
correctly. Contact GE Technical Support.

Data cannot be
acquired on the Web
Client

• Wrong Drive Card letter is specified in Client Settings.

• Wrong Primary data drive is specified in Client Settings.

Data cannot be
uploaded from the
Web Client

The ArchiveFolderPath in the holterstream.ini file on the Web
Server points to a folder that does not exist.
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MARS Web Upload Errors (cont'd.)

Problem Possible Causes

Data does not copy
from Web Server to
MARS Server

• The MARS Web option is not activated on the MARS Server.

• MARS.IDT.Slotfilecopier service on the MARS Server is stopped.

• The GEService1 user account is not set as the logon account
for slotfilecopier service on the MARS Server.

• GEService1 user account does not have Full Control
permissions to IISServerData folder on the Web Server.

• Logon account for Slot File Copier Service is not part of the
Administrators Group.

• The wrong IP address for the Web Server is in Slotfilecopier.ini
or quotes are missing.

• The TempFolderPath in the SlotFileCopier.ini points to a folder
that does not exist, or there is a syntax error in line entry
(quotes and \\).

• TheWebSlotPath in the SlotFileCopier.ini does not point to the
IISServerData folder, or quotes are missing in the line entry.

• The slots folder on the MARS Server is full. TheWeb Alert icon
displays actions that are needed.

Web Alert icon onMARS
client not working

MarsServerData folder on MARS server not shared to
MARSWORKGROUP.

MARS Web client
behavior is erratic

Internet Explorer Active X control security settings not enabled.

1 GEService is the recommended account. If you use a different account, that account
must meet both conditions listed here.
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Specific CIC Interface Error Conditions
The following table lists some specific error conditions that have been identified
with the CIC Interface option. For more detailed information, refer to the MARS V8
Installation and Upgrade Manual (2083129–002)

CIC Interface Errors

Problem Possible Causes

MARS Acquisition
Workstation cannot
acquire data from CIC

• CIC Interface option is not activated on the MARS Client.

• CIC that MARS is connecting to is not at v5 or higher.

• CIC does not have full disclosure enabled.

• CIC IP addresses specified in the CIC Configuration on MARS are
wrong. Ping the CIC from MARS.

• No connectivity between MARS workstations and CIC—no ping
returned.

• Bed was not moved into the Selected Bed list in CIC
configuration on MARS.

• Mars_cicbedsync service is not running on the MARS
Workstation.

• Mars_cicbedsync service on MARS Workstation is not set to
automatic and does not restart during a reboot.

• Default gateway set on the MARS client does not point to the
correct router. Ping the router from the MARS system.

• If one MARS workstation is able to access the CIC, compare its
settings to the workstation that is unable to connect.

NOTE:
Port 9001 must be open across the router for communication
between the MARS system and the CIC.

MARS Client on the IX
network is unable to
connect to the MARS
Server

• Server name or IP address listed in the System Network
Configuration on the MARS client is wrong.

• User on MARS client is not in the MARSWORKSGROUP users
group on both the MARS client and Server.

• Share is set up incorrectly. The gemsit file share on the MARS
server cannot be viewed from the MARS workstation.

• Default gateway on the MARS client does not point to the router
that is handling traffic to the MARS server on the Enterprise
network.

• Default gateway on the MARS server does not point to the
router that is handling traffic to the MARS workstation on the
IX network.

NOTE:
File sharing ports must be open for communication between
the MARS Client and MARS Server.
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If a MARS System becomes corrupt, it may be necessary to rebuild it. This chapter
describes that process for systems with MARS V8 running service pack 4 or later.
For earlier versions of MARS, refer to the service manual that originally shipped with
that system.

If the system being rebuilt also hosted other GE Healthcare applications (such
as CardioSoft/CS, MARS Web Server, and so forth) refer to the manuals for those
applications for instructions on backing up data, re-imaging the system, and
reinstalling the application.

Process Overview
Following is an overview of the rebuild process.

1. Back up the MARS system, if possible.

This includes the MARS configuration and activator codes and the MARS slots
and reports folders. For details, see “Backing Up the MARS System” on page
62.

2. Remove the hardware key.

The key will be needed when reinstalling the MARS application. For more
information, see “Removing the Hardware Key (Dongle)” on page 63

3. Re-image the system.

This returns the system to a state that meets the MARS hardware and software
requirements. For more information, see “Re-imaging the MARS Platform” on
page 63.

4. Reinstall the MARS system.

This involves installing, configuring, and verifying the MARS application. If
applicable, it also involves installing the MARS Web Upload system. For details,
refer to “Reinstalling the MARS System” on page 63.
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Requirements
To rebuild a MARS system, you need the following equipment:

Required Equipment

Item Description

MARS Application CD The original MARS V8 Application CD is required to reinstall the
MARS System.

External Storage External storage media or network share is required to copy
information from the original MARS system, such as system
configurations, activation codes, and slots and report
folders.

Dongle The original dongle security key is required so the MARS system
and options operate after the system is rebuilt.

Backing Up the MARS System
If accessible, the system data should be backed up prior to beginning the re-imaging
process. The backups will be used to restore the data after the rebuild is complete.

Backing Up MARS Configuration and Activator Codes
Use the following instructions to save the system configuration and activator codes
to an external backup device—such as a floppy disk drive, CD-ROM drive, or USB
flash drive—before the rebuild begins:

1. Launch the MARS application.

2. Insert the storage media in the appropriate drive.

3. Select System > System Setup > Backup and Restore.

4. Select the Backup Systems Setup check box.

5. Complete the Enter a name for the backup field.

A name is required and can be up to 70 characters long. The name is used
as the backup filename, which uses the format xxx.mars, where xxx is the
name entered in this field.

6. Complete the Enter comments for the backup field.

Comments are optional and can be up to 70 characters long.

7. Click Apply.

8. Select the appropriate drive from the Browse for Folder dialog box and click OK.

The backup begins. When it is complete, the Backup operation completed
successfully message opens.

9. Click OK.

The Backup operation completed successfullymessage closes.

10. Remove the storage media.
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Backing Up MARS Slots and Reports Folders
To back up the patient data and reports currently stored on a MARS server or
standalone system, copy the c:\gemsit\slots and c:\gemsit\reports
folders to an external backup device—such as a floppy disk drive, CD-ROM drive,
or USB flash drive—or to a network share before re-imaging the system. When
reinstalling the MARS application, you are given the option of restoring these folders
rather than creating new ones.

NOTE:
This procedure is not typically required for MARS clients, since patient data is only
stored on clients when connectivity between the MARS client and server fails. In
that situation, newly acquired data will be temporarily stored locally on the client.
When rebuilding a MARS client, you may to check the c:\gemsit\slots and
c:\gemsit\reports folders to verify there are no records to back up.

Removing the Hardware Key (Dongle)
After you have finished backing up the MARS data, remove the hardware key (dongle)
from the system you are re-imaging and store it in a safe location. This key will be
required during the reinstallation of the MARS application after the system has been
re-imaged.

Re-imaging the MARS Platform
Re-imaging the MARS platform is simply the process of restoring the system to a state
that meets the hardware and software requirements of the MARS system type you are
rebuilding (that is, a client, a server, or a standalone system). The process typically
involves reformatting the hard drive, repairing damaged partitions, and reinstalling the
operating system. Most commercial PCs come with either instructions for re-imaging
the system or an image disk that restores the computer to it’s original factory state.

Because the customer owns the equipment on which the MARS application is installed,
the customer is responsible for re-imaging the system. Refer to your equipment’s
original documentation for details.

If the customer is using legacy GE-supplied equipment, refer to the MARS service
manual that originally shipped with the equipment for instructions to re-image the
platform.

Reinstalling the MARS System
The process of reinstalling the MARS system consists of the following steps:

1. Re-partitioning the hard drive, if appropriate.

2. Reinstalling the application software.

3. Installing SEER Light Hookup, if required.

Each step is discussed in more detail in the following sections.
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Reinstalling the Application Software
When reinstalling application software, you must always reinstall the MARS system
software. If you are rebuilding a MARS server, you may also need to reinstall the MARS
Web Server and/or Morpheus Hx software.

MARS System Software
To install the MARS system software, refer to the following procedures in the MARS
V8 Installation and Upgrade Guide (PN 2083129–002):

1. Installing the MARS Application

2. Configuring the MARS System

3. Verifying the Installation

NOTE:
During the installation process, you have the opportunity to import the slots and
reports folders that you backed up earlier.

MARS Web Server Software
NOTE:

You only need to reinstall the MARS Web Server software if you are rebuilding
a MARS server on which the MARS Web Server was also installed. If you are
rebuilding a MARS client or standalone system, or if the MARS Web Server was
installed on its own hardware, you do not need to reinstall the MARS Web Server
software.

To reinstall the MARS Web Server software, refer to the following procedures in the
MARS V8 Web Server Installation Manual (PN 2083129–005):

1. Installing the MARS Web Server Software

2. Configuring the MARS Web Server

3. Configuring the MARS Server

4. Checkout and Troubleshooting

Reinstalling SEER Light Hookup Software
If you use SEER Light Connect to connect your SEER Light or SEER Light Extend
Ambulatory Recorder/Controller directly to your MARS system, reinstall the SEER Light
Hookup software. Refer to the SEER Light manual shipped with your device.
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The MARS Ambulatory ECG System is a software-only application. Customers are
responsible for the maintenance, repair, and replacement of their equipment.
Contact your equipment’s manufacturer if you need to purchase replacement parts.
Customers using legacy GE-supplied platforms can refer to the service manual
originally shipped with the equipment for a list of replacement parts. There is no
guarantee that parts for legacy hardware will still be available.

This chapter identifies the part numbers for optional peripherals and for the security
keys (dongles) required to operate the MARS Ambulatory ECG System. To order these
parts, contact the Service Parts department at the Technical Support Center.

Peripherals
GE Part Numbers for Peripherals

GE Part Number Description Qty

2008595–009 SEER Light Connect Device (Optional) 1

2027495-004 18-in-1 Memory Card Reader 1

2067634–165 SEER 1000 Connect (Optional) 1

Security Key (Dongle)
GE Part Number for Security Key (Dongle)

GE Part Number Description Qty

2020044-365 DRU - MARS USB SECURITY DONGLE 1

When ordering the security key (2020044-365) as a replacement for either an existing
damaged, defective, or lost USB dongle or for an existing parallel dongle that is no
longer supported, you must have the serial number of the existing dongle when
you call GE Customer Service. GE uses this information to ensure that all existing
entitlements (options) are transferred to the new dongle and that all licenses and GE
systems are updated with the serial number of the new dongle.
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The serial number of the existing dongle can be located from any of the following
locations:

1. The label of the existing dongle (if available).

2. The original Option Activation Sheet.

3. The MARS application’s Help > About menu.

4. The Windows registry of the system on which the MARS application was installed.

5. The GE Healthcare Service CRM System.

6. The GE Healthcare Option Activation Site (http://oac.health.ge.com/oac/).

MARS customers can use locations 1–3 to find the serial number. GE Service personnel
can use locations 1–6.

GE Customer Service will ship the dongle with a new Option Activation Sheet.
When you receive the Option Activation Sheet, you must insert the new dongle
into an available USB port and apply the new activation codes. Refer to “Software
Activators” in the MARS V8 Ambulatory ECG System Operator’s Manual (2083129-003)
for instructions.
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Slot File Tool User Guide

The Slot File Maintenance Utility allows you to add and delete slot files in a MARS V8
system configured either as standalone or server.

The utility also facilitates reconfiguring the system’s slot file repository location and
allows you to remove slot file ownership. This document is intended for a service
person or MARS administrator.

NOTE:
You cannot use the Slot File Tool with the MARS system running. Shut down the
MARS system before using the Slot File Tool to make changes to the slot files.

NOTE:
If you are using the Slot File Tool to do maintenance, you should notify other users
so they do not use the MARS system for acquisitions at the same time.

The Slot File Tool uses MARS PC registry data to:

• Verify if the MARS PC is installed on a particular machine.

• Verify if the appropriate mode of MARS PC is installed, because the tool can run
only on Server or Standalone modes.

• Locate the Slot Files Directory (default: <systemdrive>:\gemsit\slots) to load and
display them.

You can use the Slot File Tool to perform the following operations:

• Add a specified number of slot files to the Slot Files Directory, which MARS PC uses.

• Delete a specified number of slot files, a selected file , or all empty slot files from
the Slot Files Directory.

• Delete the owner of a specified slot file.

• Change the Slot File Directory in the registry, which MARS PC uses.

The Slot File Tool is located in the c:\gemsit\opt\MarsNt\bin\ folder. To launch the
application, double-click SlotFileTool.exe.
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Understanding Slot File Size, Disk Capacity, and
Performance

Before adding slots, consider the amount of available storage the slot files require and
how the number of slot files may affect MARS system performance.

With MARS V8, slot files are no longer fixed sizes. Each slot file starts out at 16 KB and
grows to fit the data as you acquire it. If the existing hard drive capacity is limited,
use the following Disk Sizing guidelines to estimate the amount of maximum space
the different slot files use. Plan the total number of slot files accordingly, so that even
if all slots are at their maximum size, there is still 5 to 10 GB of free drive space left
on the drive.

Calculating the minimum disk size consists of the following steps:

1. Determine which file types you will install

2. Determine the quantity for each type

3. Multiply the quantity for each type by the type's maximum file size

4. Sum the totals

5. Add 20 GB for OS, ancillary applications, and overhead.

NOTE:
The Available and Free values displayed under Drive Capacity are not used in the
MARS V8 system. This information was originally intended to allow you to set a limit
on the amount of drive space available for the Slot Files. With the dynamic nature
of the slot files in the MARS V8 system, this becomes more difficult to calculate.

As the number of slot files increase, it may take longer for the Patient List to display.
This is more noticeable for workstations operating at the lower range of the system
hardware requirements. If a user, or users, complain of slow performance after adding
slot files, consider reducing the number of slots.

NOTE:
Additional slots are not a substitute for a good archival process. MARS is not
designed, and should not be used, for long-term storage.

Setting Slot Files Location
1. Click the ellipses button under the Slot File Location section.

The Browse for Folder dialog box opens.

2. Locate the Slot file directory folder in the dialog box.

For most installations, the slots folder is located in c:\gemsit.

3. Click OK.

All the slot files within the selected folder are displayed showing the type, status,
and size of each slot.

4. Select the DATA_IS_AT, located in HKEY_LOCAL_MACHINE\SOFTWARE\GEMS
IT\MARS\8.0.

The Slot File Location defaults to the current slot folder location, as defined in
the registry entry. This is the slot folder location the MARS system is currently
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using to save data. There is no need to change this location. The slot file location
is generally c:\gemsit\slots.

NOTE:
The Set As Default Slot File Location check box changes the entry in the
registry setting. This is NOT RECOMMENDED and you should not perform
this step. Use the tool only to add or delete slot files from the current slot
folder location.

Adding Slots
See “Understanding Slot File Size, Disk Capacity, and Performance” on page 68 for
more information about slot files.

1. Type a number (or use the up/down arrows to select a number) in Add
Slots>Number.

The tool limits the number of slots to 255 for each slot type.

2. Select the slot type from Type.

Slot File Types

Slot File Type Description

SEER Stores data from SEER Light, SEER Light Extend, SEER MC,
and SEER 12

TAPE* Stores data from the 8500 Tape drive

MON Stores raw, unanalyzed monitoring data

ACQ Stores analyzed monitoring data

*The MARS system no longer acquires data from this tape drive, but you can restore
archive tape recordings to these slots

3. Click Add.

4. Empty slots are added to the bottom of the slot list.

Click the Refresh button to regroup the slot list by type.

5. To verify if the slots were created, go to the actual slot file location specified in
the tool, and check that the slots are now there.

For example, default slot files path: <MARS installation drive>\gemsit\slots.

6. Restart the system if you are not performing another task.

See “Restarting the System” on page 73 to restart the machine.
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Deleting Slots
You cannot delete slots containing data.

Deleting Empty Slots
Use Delete in the Remove Slots section to delete empty slots of the slot type you
choose. Slots are deleted starting from the bottom of the list.

1. Select the slot Type under the section Remove Slots.

2. Type a number (or use the up/down arrows to select a number) in Remove
Slots>Number.

NOTE:
Enter a number from one (1) to the total number of empty slots in the file.

3. Click Delete.

The following message is displayed: Are you sure you want to delete?

4. Click Yes to delete the number of empty slot files you indicated.

5. The slots are deleted starting from the bottom of each slot type.

6. To verify that the slots were deleted, go to the actual slot file location specified
in the tool and check that the slots are now gone.

For example, default slot files path: <MARS installation drive>\gemsit\slots.

7. If you are not performing another task, restart the system.

See “Restarting the System” on page 73 to restart the machine.
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Deleting Selected Slots
Use Delete Selected in the Remove Slots section to delete specific empty slots from
the list.

1. Select the check boxes in front of the empty slot(s) you want to delete.

2. Click Delete Selected.

The following message is displayed: Are you sure you want to delete these
<number of files selected> items?

3. Click Yes to delete the selected slots.

4. The selected slots are deleted from the list.

5. To verify if the slots were deleted, go to the actual slot file location specified in
the tool and check that the slots are now gone.

For example: default slot files path: <MARS installation drive>\gemsit\slots.

6. If you are not performing any more tasks, restart the system. See “Restarting
the System” on page 73 to restart the system.
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Deleting All Empty Slots
Use Delete All Empty Slot Files in the Remove Slots section to delete all empty slots
from the list.

1. Click Delete All Empty Slot Files.

The following message is displayed: Are you sure you want to delete?

2. Click Yes to delete all of the empty slot files.

3. All empty slots are deleted from the list.

4. To verify if the empty slots were deleted, go to the actual slot file location
specified in the tool and check that the slots are now gone.

For example, default slot files path: <MARS installation drive>\gemsit\slots.

5. If you are not performing any more tasks, restart the system. See “Restarting
the System” on page 73 to restart the system.

Deleting the Slot File Owner
A slot file is “locked” if someone is using it or the system crashes while someone was
using the file. If a file has an owner, you cannot make changes to that file. Use Delete
Owner in the Owner section to delete the owner from the selected slot file.

NOTE:
Make sure the owner is not really using the file before deleting them.

1. Highlight the row(s) that display owner information.

2. The Delete Owner button is enabled.

3. Click Delete Owner.

The following message is displayed: Are you sure you want to delete owner?

4. Click Yes to delete the owner from the slot file(s).

The owner information is deleted from the patient file in the list.

The tool also deletes the small owner file created in the slot files directory.
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Restarting the System
After you complete changes to the MARS system, you need to restart the system.

1. Click Restart or select File->Restart from the menu.

The following message is displayed: Do you want to restart the computer now?

2. Click Yes to restart or No if you do not want to restart the system at this time.

NOTE:
You should restart the system once after Adding or Deleting slots.

Closing the Slot File Tool
When you are finished making changes to the slot file, close the tool.

1. Click Close or select File —>Close from the menu.

The tool closes.
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The following message is displayed: It is strongly recommended that you
restart the system for the successful execution of MARS PC. Do you want
to restart the system?

2. Click Yes to restart the system or No to close the tool without restarting the
system.
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Dongle Drivers

The MARS system uses a USB dongle to authenticate the MARS V8 software. It is
included in installation kits and in upgrade kits for versions earlier than 6.5. When
upgrading systems running MARS version 6.5 or later, reuse the existing dongle.

Installing the Dongle Drivers
When installing the MARS software on a physical computer, the dongle drivers are
installed automatically. However, when installing the MARS software on a virtual
machine, the dongle drivers must be installed manually on the physical machine to
which the dongle will be attached.

1. On the release media, locate the \SuperPro folder.

2. Double-click Sentinel_Protection_Installer_7.6.1.exe.

The installer’sWelcome window opens.
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3. Click Next.

The License Agreement window opens.

4. Review the agreement and then select I accept the terms in the license
agreement and click Next.

The Setup Type window opens.

5. Select Complete and click Next.

The Ready to Install the Program window opens.
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6. Click Install.

One of two things happens.

• If the Windows firewall is enabled, theWindows Firewall detected! window
opens.

Skip to step 7.

• If the Windows firewall is not enabled, the dongle drivers are installed.
When the installation is complete, the InstallShield Wizard Completed
window opens.

Skip to step 8.
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7. If theWindows Firewall detected! window opens, click Yes to allow the dongle
attached to the physical machine to be accessible over the network.

The dongle drivers are installed. When the installation is complete, the
InstallShield Wizard Completed window opens.

Proceed to step 8.

8. On the InstallShield Wizard Complete window, click Finish.

The installer closes.

9. Open theWindows Control Panel and confirm that Sentinel Protection Installer
7.6.1 was installed.
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Optional Card Readers

MARS V8 systems running service pack 4 or later support two optional data card
readers: the 18-in-1 Memory Card Reader and the OmniDrive Professional Card
Reader (USB).

18-in-1 Menory Card Reader
The 18-in-1 Memory Card Reader (PN 2027495-004) is an optional peripheral that
allows you to acquire ECG readings from the memory cards of all the Holter devices
supported by the MARS Ambulatory ECG System. This chapter identifies the card
reader’s components and detail’s its technical specifications.

Components

Card Reader Components

Item Name Description

1 Card Slot Slot for CompactFlash Cards

2 Card Slots Additional slots for other types of cards.
Not used.

3 USB Port Connect the USB connector to the port on the back of
the card reader and the MARS Ambulatory ECG System.
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Specifications
The following table provides the technical specifications for the optional 18-in-1
Memory Card Reader.

18-in-1 Memory Card Reader

Component Description

Interface USB 2.0
USB 1.1 compatible

Transfer Speed Up to 480 Mbps, dependent on card and USB connection

Supported Card Types • CompactFlash Type I

• CompactFlash Type II

• MicroDrive

• MagicStor

• SmartMedia

• Memory Stick

• Memory Stick Pro

• Memory Stick Duo

• Memory Stick Select

• Memory Stick Pro
Duo

• Secure Digital (SD)

• Secure Digital High Capacity
(SDHC)

• TransFlash (microSD)

• Multimedia Card 4.0 (MMC
Plus)

• Multimedia Card (MMC)

• Reduced Size MMC 4.0
(MMC Mobile)

• Reduced Size MMC

• xD

Dimensions (H x W x L) 0.68 x 2.30 x 3.94 inches
17.3 x 58.6 x 100 millimeters

Weight 2.54 ounces
72 grams

Power Consumption DC 3.3V/5V
100 mA (maximum)

Operating Temperatures +32° to +158° F
0° to +70° C

Operating Relative Humidity 50%

Storage Temperatures –40° to +158° F
-40° to +70° C

Storage Relative Humidity 5–95%

OmniDrive Professional Card Reader (USB)
The OmniDrive Professional Card Reader (USB) is no longer available from GE
Healthcare. However, it is still supported for 32-bit operating systems, and the
necessary drivers are automatically installed when the MARS system is installed on a
32-bit operating system.
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Optional Card Readers

Customers who require data acquisition from the Linear Flash (PCMCIA) card used by
the SEER MC recorders should consider replacing these recorders with the SEER 12
Holter recorder. SEER 12 data is acquired using the 18-in-1 Memory Card Reader.

NOTE:
Due to slow transfer speeds, the OmniDrive reader cannot be used to acquire
data from a SEER 12 Holter recorder.

Components

OmniDrive (USB)

Item Name Description

1 Card Eject Button Push the button to eject the card.

2 Power On Indicator Green LED is lit when power is on. (Power is applied
through the USB cable.)

3 Busy Indicator Red LED is lit when transferring data.

4 USB Connection Connect the USB cable to the port on back of the
OmniDrive and to a USB port on the MARS Ambulatory
ECG System.

Specifications
The following table describes the specifications for the OmniDrive (USB) card reader.

OmniDrive Card Reader

PC Card Slots 1x Type II front slot

Interface USB 1.1/2.0

Data Transfer Speed Up to 1 MB/sec
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Optional Card Readers

OmniDrive Card Reader (cont'd.)

Supported Card Types • SRAM

• ATA Flash

• ATA Hard Disk Type II

• CompactFlash

• SmartMedia

• Secure Digital Cards

• Multimedia Cards

Dimensions (HxWxL) 1.37 x 4.29 x 5.31 inches
35 x 109 x 135 millimeters

Weight ~10.58 ounces
~300 grams

Operating Temperature 32° — 158° F
0° — 70° C

Storage Temperature -4° — 185° F
-20° — 85° C

Humidity 90% maximum, non-condensing in ambient

Power Supply DC 5 V from PC via USB
220 V / 110 V from optional AC power supply

Supported Operating
Systems

Microsoft Windows 98, 98SE, ME, 2000, XP, Vista
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GE Medical Systems
Information Technologies, Inc.
8200 West Tower Avenue
Milwaukee, WI 53223 USA
Tel: +1 414 355 5000

+1 800 558 5120 (US Only)

GE Medical Systems Information Technologies, Inc., a General Electric Company, going to market as
GE Healthcare.

www.gehealthcare.com
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